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第十八章  Style 风格 面板

我们都知道 以前版本的 Photoshop 是一个纯位图图形软件 而许多著名的软件如

CorelDraw Freehand 等都是既能处理位图图形也能处理矢量图形 因此这也成为位图图

形软件霸主的 Photoshop 的一个缺陷 Style 风格 面板的出现改变了这一状况 这是一

个专门处理矢量图形的面板 它是由一个或者多个的层效果和混合选择组成的 需要注意

的是 并不是所有格式的图形它都能处理 Style 风格 面板只对 Vector 矢量 图形和

Layer 图层 才可以使用 你可以用它已有的 Style 也可以自己定义新的 Style 只要把

你应用到一个层上的效果加到 Styles 的调板中就可以了

18.1  Style 面板功能介绍

        

                      图18-1  Styles面板                   图18-2  面板弹出菜单

首先我们来看一看 Styles 风格 面板上面的缩略图表示对矢量图形或层处理后的效

果 如果对你所做的风格操作不是特别满意的话 可以点击右下角的第一个图标 它可以

将图形恢复到没做风格以前的样子 而 则是用来新建一个 Styles(风格) 下面我将对

Styles 面板的弹出菜单作一个介绍

•  New Styles 新建风格 前面已经提到 风格实际就是对一个层作一些 Effects 效

果 变化 在预览中得到满意的效果后 加入到 Styles(风格)面板中就可以了 稍

后我们将就 Styles 风格 的制作举一个例子

•  Reset Styles 重置 Styles(风格) 它将使面板回到默认的模式 在这之前一定要对

自己制作的面板进行保存 否则该 Style 风格 将会丢失

•  Load Styles 从安装文件中载入 Style 风格 这样我们就有更多的 Style 风格

可供选择

•  Save Styles 保存所制作的 Style 风格



•  TextOnly 在面板属性栏只以文字显示各种 Style 风格

•  Small Thumbnail 在面板属性栏以小缩略图显示各种 Style 风格 图 18-12 即
是此种形式

•  LargeThumbnail 大缩略图 即以较大的图标显示各种 Style 风格

•  Small List 小列表 这种形式既有图标 又有文字显示 Style 风格 但需要占

用比其它模式更多的内存 总之 显示的信息越丰富 所占内存越多

•  Large List 大列表 同小列表相似 但图标和文字均较大

•  SampleStyles.asl 风格样本 点击它即可载入一些新的 Style 风格 其功能和 Load
Styles 载入风格 类似

在选择 Save Styles 保存风格 时 将弹出如图 18-3 的窗口 在对它命名之后 单

击 OK 就可以了 在选择 Load Styles 载入风格 时 其操作过程类似

图18-3  载入风格窗口

现在我们将就制作新的 Style 风格 举一个例子 这里将涉及到图层的内容 如果

用户是个初学者 则可以先跳过此例 等学完图层后再回头看一下本例 相信对学习图层

也会有帮助的!!

18.2  Style 制作讲解

1. 打开 18-5 图画 这里需要注意的是 我们打开的图像在 Photoshop 默认为是背景

它不是一个层 而且 Photoshop 6.0 的使用不支持拷贝背景为层 这时可以双击 Layer 层

面板中的背景层 则会弹出如图 18-4 的窗口 使用默认的参数 单击 Ok 关闭窗口即可 参

数的设置我们将在下一节中详细练习 则原来的背景就转化为一个图层了 值得注意的

是 这时图像的背景层是透明的 此时我们就可以对 Layer 层 使用 Effects 效果 了

2. 开 Layer 面板 其版面的设置为默认值 在 Photoshop 6.0 中面板设了几个锁定选

项 应使它们处于非锁定状态才可以处理图层 在右上角的下拉菜单中选择 Blending
Options 混合选项 或者单击面板下方的 f 图标 任选其中的一项 则将弹出如图 18-7
所示的版面 然后根据自己的喜好或需要设置面板中的参数值 图 18-5 如果按照图 18-7



所示的设置则得到图 18-6 的处理效果

图18-4

    
             图18-5  待处理的图形                          图18-6  风格化后图形

图18-7  图层混合参数设置

3. 单击 New Style 按钮 不同的选择将出现如图 18-8 的四个界面



  

  

图18-8

比较图 18-8 的四个界面 我们可以知道 所有的 Style 风格 都必须包含 Layer Effects
层效果 否则 我们辛苦做出的只能是一个用以消除 Style 风格 历史的无用的风格

如果我们在第 2 步的操作过程中涉及层的 Blending Options 混合选项 还必须也将该复选

框选中 否则 过程中的混合效果将被舍弃 最后别忘了为自己的作品选一个美丽的名字

4. 在对所有的界面都点击 OK 关闭之后 我们就得到了自己制作的 Style 风格 制

作前后 Style 风格 面板的属性栏如图 18-9 和 18-10 所示

       

                  图18-9  制作前                           图18-10  制作后

相对图 18-9 图 18-10 属性栏多出的图标即我们的作品 如果你觉得做得效果不理想

的话 单击该图标 将它拖到右下角的 即可清除这个 Style 风格 反之 当你制作

出理想的 Style 风格 后 最好马上保存 否则重置 Style 风格 时它会被丢弃

至此 我们的 New Style 新风格 已经制作完毕 你学会了吗

现在我们回顾一下 Styles 面板 的学习过程 如果你是一个 Photoshop 的老用户

就会发现 Styles 面板 的使用和 Actions 脚本 面板的使用方法相类似 都比较简便

只要找到合适的样本 用鼠标点击就可以了 而制作出完美的 Style 风格 的过程虽然

稍微复杂 但只要我们掌握了 Layer 图层 的使用方法 就基本上没问题了

本章小结本章小结本章小结本章小结

本章我们主要介绍了 Photoshop6.0 中一个全新的面板 即 Style 面板 其中介绍了该

面板的使用 并就如何建立一个新的 Style 举了一个例子 这个面板的使用类似 Action 面

板 虽然它们的制作过程是完全不一样的 它们都是只要单击面板上的图标就可完成操作



的功能

使用这个面板时 我们首先要理解 Style 风格 这个新的概念 它就是对图层的操

作保存下来以后 在我们打开一个新的图层的时候 对该图层实施同样的操作 比如说

我们在某一次对图层的处理时得到一个效果很好的图层 其中就可以将对图层所作的

Effects 效果 的操作保存为一个新的 Style 风格 在下次对一个图层进行编辑的时候

就可以将 Style 风格 应用到这个图层上 得到和上次的图层一样的效果 通过练习

我们会很快掌握这个新的面板的用法的

我们已经知道 Style 风格 是对图层的操作而言的 所以我们学习这部分内容的时

候 要注意结合在下一章提到的 Layer 图层 内容



第十九章  History 历史记录 面板

历史记录可以将图像处理过程中的有限步骤的历史记录删除 回到那些步骤以前的图

像 我们在图像上进行的每一个处理 在历史记录的面板上都有记录 因此如果我们在操

作中发现有些步骤做得不是特别理想的话 可以通过还原历史记录进行恢复 在

Photoshop6.0 中 系统设置的恢复操作的最大的步数是 20 步

19.1  历史面板

从 Window 窗口 菜单中我们打开如图 19-1 所示的历史记录控制板

      

                           图19-1                                  图19-2

图中各项的含义如下

A 单击该位置 在该位置将会出现 的标志 表示将在位置设置历史记录画笔 当

我们对图像的处理步数超过 20 步时 后面的操作产生的记录将会把前面的记录覆盖 如

果在该步设置 的话 就可以随时在过程中回到该步

B 单击该图标 时 我们将从图像的当前状态建立新的图像文档 即在 Photoshop
界面中出现两个该图像的当前状态 我们可以同这个功能比较图像处理前后的变化情况

C 单击该图标 时 将会为当前的处理情况建立一个新的快照 这个选项的

功能和稍后提到的 New Document 新文档 是类似的

D 在选中某一个历史记录的情况下 单击该图标 则将该记录及其以后的记

录全部删除 通过改变历史记录选项 我们可以只删除其中被选中的历史记录

E 这是 Photoshop 在打开图像时为我们创建的新快照 是其默认的 也可以通过 C
选项做到

在选中某一个历史记录的情况下 我们用右键单击该记录 则将弹出如图 19-2 的窗

口 我们可以建立 New Snapshot 新快照 Delete 删除 Clear History 清楚历史记录

New Document 新文档 在这里我们要注意 Delete 和 Clear History 的区别 Delete 删

除 只是将选中的步骤删除 而 Clear History 清除历史 则是将除了历史记录中的第一



步外所有的记录全部删除

19.2  历史面板的相关菜单

         

图19-3

1. Step Forward 选择这个选项 就会将历史记录前进一步

2. Step Backward 选择这个选项 就会将历史记录后退一步

3. New Snapshot 见前面

4. Delete 见前面

5. Clear History 见前面

6. New Document 新建文档

7. History Options 历史选项 选择这个选项 将会打开如图 19-4 的窗口

图19-4

图中共有四个选项 它们从上到下依次是

•  Automatically Create First Snapshot 自动创建第一快照

•  Automatically Create New Snapshot WhenSaving 存储时自动创建新的快照 便于

比较每次存储时图像的效果

•  Allow Non-Linear History 允许非线性历史记录存在 在 Photoshop6.0 中默认的

历史记录选项是线性的 即如果删除前面的记录的话 后面的记录也是一起被删

除的 如果我们允许非线性历史记录存在的话 那么我们就可以任意删除面板中

不需要的记录了 但是它只能一步一步删除记录 用起来不方便 我们一般在特

殊情况下用到它 两者的区别在面板上也可以看出来 非线性选项被选中记录后

边的记录是清晰的 而线性选项被选中记录后边的记录是灰色的

•  Show New Snapshot Dialog By Default 以默认的形式展示新快照的对话框

 Step Forward 前进一步

 Step Backward 后退一步

 New Snapshot 新建快照

 Delete 删除

 Clear History 清楚历史

 New Document 新建文档

 History Options 历史选项



需要注意的是 虽然我们可以在面板上保存很多的历史记录 但是 保存历史记录是

需要较大的内存的 有些滤镜或者一些变化的历史需要较大的磁盘空间 我们应该根据需

要选择保存一些记录 有一个诀窍 就是对于一些可有可无的历史记录尽量不保存 例如

Select 选择 和 Deselect 除去选择

本章小结本章小结本章小结本章小结

本章主要介绍了历史记录面板的用法 Photoshop 之所以能让用户如此方便的使用

不仅是它具有强大的处理图像的工具和图层等功能 更因为它有一个功能强大的历史记录

面板 在这个历史记录面板中 我们可以随心所欲地对图像进行编辑 对于我们编辑过程

中不满意的操作进行删除 这样我们的处理就可以无所顾忌地发挥我们的创造力以进行创

作

使用面板的过程中 我们应该根据需要对历史记录的面板进行设定 在适当的时候

我们应该对图像建立新快照进行快速的保存 在使用过程中 我们有必要了解一下相关的

快捷键的使用 按住 Ctrl 键 并且单击 Z 键 则可以取消前一步的操作 在执行这个操

作的话 那么我们对图像的操作将回到后一步 如果在按住 Ctrl+Alt 的情况下 单击 Z 键

重复操作则可以无限次的取消以前的操作 在了解这些操作常识之后 会使我们的使用更

加快捷



第二十章  Action 动作 面板

我们在实际处理图像的过程中经常需要对大量的图像采用同样的操作 如果我们一个

一个地进行处理的话 不仅速度十分慢 而且许多参数的设置往往会发生错误 从而影响

整体的效果 在 Adobe Photoshop 中 Action 动作 面板具有下列主要功能

1. 可以将一系列命令组合为单个动作 从而使执行任务自动化 这个动作可以在以

后的应用中反复使用

2. 可以创建一个动作 该动作应用一系列滤镜效果重现你所喜爱的效果 或者组合

命令以准备以后用来图像 Action 动作 可被编组为 Set 序列 以帮助你更好地组织

Action 动作 使用以上的例子 可以创建一系列 Action 动作 其中的每个 Action 动

作 运用不同系列的滤镜

3. 可以同时处理批量的图片 可以在一个文件或一批文件 位于同一文件夹中的多

个文件 上使用相同的 Action 动作

4. 使用动作调板可记录 播放 编辑和删除动作 还可以存储 载入和替换动作序

列

20.1  Action 动作 面板

20.1.1  Action面板的基本功能

我们从 Window 窗口中单击 Show Actions 展示动作 则会出现如图 20-1 的面板

图20-1  Actions面板



面板上的各项功能如下

•  A 序列 它显示的是当前的动作所在的文件夹的名称 图中的 Default Action 默

认动作 文件夹是 Photoshop 默认的设置 看它的图标很像一个文件夹 它里面

包含了许多的 Actions 动作

•  B 切换项目开关 如果面板上的动作的左边有该图标的话 这个 Action 动作

就是可执行的 否则这个动作是不可执行的 如果 Set 序列 前没有图标  的
话 就表示该 Set 序列 中的所有动作都是不可执行的

•  C 切换对话开关 若在该选框中出现图标 则在执行该图标操作所在的 Action
动作 时 会暂时停在有图标 的位置 在我们对弹出窗口的参数进行设定之

后单击 OK 则动作继续往下执行 若没有图标 则动作按照设定的过程逐步

进行操作 直至到达最后一个操作 完成 Action 动作 仔细观察我们会发现

有的图标 是红色的 那就表示该动作中只有部分动作是可执行的 如果我们

在该图标上单击的话 它会自动将动作中所有不可执行的操作全部变成可执行的

操作

•  D 展开工具 单击小三角形 如果是一个 Set 序列 的话 那么它将会把所有

的动作都展开 如果是一个 Action 他将会把所有的操作步骤都展开 而如果是

一个操作的话 它将把执行该操作的参数设置打开 从这里我们可以清楚地知道

Action 是如何形成的 它是由一个个的操作集合到一起形成的

•  F 单击那个小三角形 将会弹出 Action 面板的下拉菜单

•  G 停止录制 这一行的选项的使用很像一台收音机 图标 就是停止录制动

作的按钮 它只有在录制动作时才是可用的

•  H 开始录制 单击该按钮时 Photoshop 开始录制一个新的 Action 处于录制状

态时 图标 呈现红色 此时这个按钮是不可用的

•  I 动作回放 或执行动作 当我们做好一个 Action 动作 时 可以用这个选

项观看制作的效果 单击图标 则自动执行动作 如果中间我们要停下来看

一下的话 可以单击图标 停止

•  J 单击图标 就可以新建一个 Set 序列

•  K 单击图标 可以在面板上新建一个 Action 动作

•  L 单击图标 可以将当前的 Action 动作 或者 Set 序列 或者操作删除

20.1.2  Action面板的打开菜单

单击处的小三角形 可以打开面板上的菜单 如图 20-2 这个打开菜单相对于以前的

版本来说增加了下面的优化部分 我们在菜单的右边加以中文的解释 用户在使用的时候

可以需要依据中文的名称决定所采用的模式 另外这些优化的动作序列也可以通过载入完

成 下面我们列出一个 Action 动作 可以制作的效果 以供大家参考

1. 制作一些精美的按钮 这些按钮的颜色可以在执行动作的过程中加以设定 还可

以设定按钮的样式 浮雕的效果等

2. 给图像加上一些精美的边框 这些边框如果你用其它工具来制作的话会很费时间



而且得到的效果却不一定很理想 Action 却能很快地做出好看的效果

        

图20-2  Action打开菜单

3. 使用 Image Effects.atn 图像效果动作序列 给图像加上一些效果 这些效果一般

是由一系列的操作和滤镜等组合而成的 如果在非 Button 按钮 模式打开这些动作 我

们就可以学习各种工具的参数设定的技巧了 当然 这些只能通过实践熟练以后才能做到

的

4. 制作纹理 利用菜单中 Textures.atn 纹理动作序列 我们可以制作一些背景和纹

理 不用说 这些纹理都比较精美 可以用来作一些网页的背景

5. 还可以用来对文本进行一些编辑 Text Effect.atn 文本效果动作序列 就是为这

个目的而设定的

如果我们不是要对动作进行编辑的话 我们一般是将动作面板置于 Button 按钮 模

式下 虽然 Photoshop 默认的模式是列表模式 我们选择按钮模式 那么那些按钮的使用

 New Action 新建动作

 New Set 新建序列

 Duplicate 复制动作或序列

 Delete 删除动作或序列

 Play 回放或播放动作

 Start Recording 开始记录动作

 Record Again 再次记录动作

 Insert Menu Item 插入菜单项目

 Insert Stop 停止插入

 Insert Path 插入路径

 Action Options 动作选项

 Playback Options 回放选项

 Clear All Actions 清楚所有动作

 Reset Actions 重置动作

 Load Actios 载入动作

 Replace Actions 替代动作

 Save Actions 存储动作

 Button Mode 按钮模式

 Buttons.atn 按钮动作序列

 Commands.atn 命令动作序列

 Frames.atn 框架动作序列

 Image Effects.atn 图像效果动作序列

 Production.atn 产品动作序列

 Text Effect.atn 文本效果动作序列

 Textures.atn 纹理动作序列

 Default Actions.atn 默认动作序列



就变得和滤镜的使用一样简单了 这里要注意的是在按钮模式下的动作是不可编辑的 单

击打开菜单的 Button Mode Action 面板就会变成如图 20-3 B 的模式 在图 20-3 中我

们将按钮模式和文本模式的面板作一对比

      

            图20-3 A   Action面板模式的1        图20-3 B   Action面板模式的2

20.2  新建 Action 动作

在这一部分 我们主要通过例子的讲解使用户了解新建 Action 的过程 要建立新的

Action 我们单击面板上的图标 或者在打开菜单中选择 New Action 则会弹出如图 20-4
的对话框

      
   图20-4 A                 图20-4 B   NewAction对话框                  图20-4 C

•  在 Name 对话框中 我们可以给动作取一个合适的名称

•  Set 序列 我们在下拉菜单中选择 Action 要加入的序列 即将动作放进某一个

序列之中

•  Function Key 功能键 即我们常说的热键 参加功能见键设置的键有 F2 到 F12
共 11 个 如果我们配合后边的 Shift 和 Control 键 就可以设定出大量的功能键来

如果我们选择的是 None 那么就不能设置热键了 如果一个原来的 Action 动作

我们现在要比较常用到 我们可以对该动作进行重新命名和设定热键 具体方法



是双击面板上的 Action 缩略图 在列表的模式下 则也会弹出如图 20-4 的对话

框 在对话框中 我们可以完成这些步骤

•  在 Color 选框中 我们可以设定 Action 按钮模式的按钮的颜色 可供选择的颜色

的种类如图 20-4 右边的几种 如果我们选择的是 None 的话 表示在转化为按钮

模式时 该动作在面板上的缩略图是和面板一样的灰色 有时候我们可以根据

Action 的颜色进行归类 以方便以后使用 当然 我们也可以利用 Set 序列 进

行归类

下面我们举例介绍一下创建一个新的 Action 的过程

1. 在面板上新建一个 Set 序列 这样可以将我们创建的 Action 保存在该序列中

区别于其它 Photoshop 自带的 Action 或者 Set 便于我们以后进行编辑或者删除这些我们

自己创作的 Actions 如图 20-6 我们创建一个 Set 并在其中建立一个 Action
2. 单击图标 从现在开始我们进行的操作一般都会在该 Action 中记录下来 我

们对当前的图像实施一些操作 我们先用 Airbrush 喷枪 在图上随意涂画 可以看见

在面板上已经记录了 同样 我们用 History 画笔等工具在图像上操作时 Action 会记录

这些操作 但是 并不是所有的动作都有记录的 许多操作在 Action 面板上是不可见的

3. 在完成对图像的所有操作之后 我们单击图标 即可停止记录我们对图像的操

作 得到我们制作的动作

      

                  图20-5  新建Action                   图20-6  正在创建的Action

20.3  使 用 动 作

在我们完成 Action 的制作之后 要在实践中运用它 当然 我们也要使用 Photoshop
默认的 Actions 使用 Action 的形式有两种 它们分别是对单一图像使用 Action 和对大批

的图像使用相同的动作



20.3.1  对单一图像运用 Action 动作

使用动作时 我们首先要打开一幅图画 例如我们打开图像 20-7 然后我们使用 Action
面板中的 Action Wood Frame 50Pixel 对它进行处理

      

                   图20-7  原图像                               图20-8  Action面板

我们可以通过如图 20-8 的面板模式进行 在按钮模式中 我们只要双击该按钮即可

在列表模式下 我们要在选中该 Action 的情况下单击图标 如图 20-10 所示 就可以

开始对图像进行该 Action 中的操作 两种方法都得到如图 20-9 的效果图像

      

             图20-9  执行Action后的图像                         图20-10  列表模式

从得到的图像中我们可以发现 图像增加了一个精美的边框 如果在我们精心制作的

图像上加上一个边框的话 可以起到画龙点睛的作用

20.3.2  批处理

这部分的内容我们在 File 窗口中已经提到了 这里不再重复 批处理对 Action 来说

是一个很重要的功能 希望用户能回去复习一下有关的章节



20.4  编辑 Action 动作

在我们执行动作的过程中 可能觉得动作执行的速度不是特别适宜 或者想了解它的

相关设置是如何工作的 就有必要学习如何编辑 Action

20.4.1  重名/移动/复制/删除 Action

1. 重命名 Action 我们在列表模式下双击 Action 的名称 即会弹出如图 20-11 的窗

口 在窗口中 我们可以重新命名 Action 而且可以设置 Action 所在的 Set 序列 Action
在面板上的显示的颜色以及 Action 的热键

图20-11

2. 移动 Action 我们用鼠标单击某个动作后拖动到合适的位置即可

3. 复制 Action 选中该 Action 拖到面板上的图标 即可完成复制 或者我们可以

用面板下拉菜单中的 Duplicate 完成这个操作

4. 删除 Action 选中要删除的 Action 单击面板上的图标 或者选中下拉菜单的

Delete Action 选项 这时会弹出如图 20-12 的对话框 在我们确认之后 单击 OK 即可

还有一种不弹出对话框的方法 就是直接将 Action 拉到图标 上即可 如图 20-13 所示

      

                 图20-12  删除Action对话框                          图20-13

20.4.2  编辑 Action 的内容

1. Start Recording 开始录制 执行菜单中的这个选项 可以在选中的 Action 中增加

录制动作 即在原有 Action 的基础上 插入新的操作 默认的模式下 新增的动作只能



出现在 Action 的最后面 如果我们选择的是 Action 的一个操作的话 那么新增的命令将

会出现在该操作的下面

2. Record Again 重新录制 对于一个 Photoshop 中级或者高级的用户来说 我们经

常会发现动作中某些参数的设置和我们的需要是不符合的 而我们又要经常用到这个

Action 动作 这时我们在列表模式下 可以双击该动作 则会弹出该操作的参数设置

窗口 在窗口中我们可以重新设置这些参数 这是比较高级的操作 但初级用户也可尝试

进行 只要我们在对 Action 进行修改之后 单击打开菜单的 Reset Actions 则回到原来

Photoshop 默认的参数设置 下面我们就简单介绍一下这个过程 选择面板的下拉菜单中

的 Record Again 这个选项可以将我们选中的 Action 重新录制 有一点要注意的是 录制

时我们只能在原有的操作上进行重新设置参数 而不能更改操作 即如果原来是一个填充

的操作的话 我们在更改时也只能更改填充参数的设置

在列表模式下 我们双击面板上的某一个 Convas Size 画布大小 操作 则会弹出

如图 20-15 的 Convas Size 对话框 在这个对话框中 我们可以重新设置这个操作的各种

参数 设置完成后单击 OK 确定即可

3. Insert Menu Item 插入菜单项目 弹出如图 20-16 的对话框 提示我们用鼠标在窗

口中选择一种操作 注意这些操作只能是页面上部的各种下拉菜单中的 例如 Filter 滤

镜 Image 图像 中测选项

      

                  图20-14                                     图20-15

图20-16  Insert Menu Item对话框

图 20-17 是我们在 Insert Menu Item 对 Action 动作 选择 Filter/Artistic/Colored Pencil
前后面板的示意图 添加操作之后 我们再执行该工作的话 在图像上就表现出添加的操

作的影响



    

                     图20-17 A                          图20-17 B

4. Insert Stop 插入停止 在执行动作时 你如果要自己加入一些 Action 无法记录的

操作步骤的话 我们可以用到这个选项 在我们做好操作之后 必须单击图标 继续动

作的执行 我们在设置 Stop 时 也可以考虑设置一些提示性的信息 这些信息可以在下

次你用到这个 Action 时提醒你现在应当做哪些操作 至于这些操作的参数的设置 你可

以根据图像的风格和需要重新设置

下面我们介绍一下 Insert Stop 的过程 首先我们选择一个操作 我们插入的停止的位

置是在选中的动作完成之后 这一点我们从图 20-19 中可以看出 然后我们单击面板下拉

菜单的 Insert Stop 则会弹出如图 20-18 的对话框 在这个对话框中 我们在 Message 选

框中输入信息 可以是一些指令 如我们输入 请用画笔工具描边 的字样

      

                 图20-18  Insert Stop对话框                      图20-19  InsertStop后的面板

至于 Allow Continue 允许继续 是表示我们是否允许不执行任何操作而继续下面的

操作 图 20-20 是不选中 Allow Continue 时我们执行该动作时弹出的对话框 而图 20-21
则是我们选中 Allow Continue 时弹出的对话框 从对比中我们可以知道 Allow Continue 的

功能



      
                  图20-20                                     图20-21

5. Insert Paths 插入路径 前面我们已经提过 不是所有的操作都能被记录的 但

是有的操作对我们的创作极为关键 路径就是其中的一种 为了方便用户 Photoshop 提供

将插入 Path 路径 的选项 在插入路径时 我们先在图像上制作一个路径或者导入一个

路径 然后执行 Action 面板的下拉菜单中的 Insert Path 即可在 Action 中得到 Set Path 建

立路径 的操作 现在使用这个 Action 时就会出现路径的影响了

20.5  Action 的选项

1. Set Options 序列选项 单击面板下拉菜单的该选项 会弹出如图 20-22 的对话框

这选框中 我们可以对序列进行重命名

图20-22

2. Playback Option(回放选项) 我们单击打开菜单的 Playback Option 则弹出如图 20-23
的窗口 它的各个选项的含义如下

图20-23

•  Accelerated 加速 这是 Photoshop 默认的模式 执行速度最快

•  Step By Step 逐步 这种模式的执行速度较慢有利于我们看清楚每一步操作的

效果

•  Pause For 暂停时间 这个选项可以调整每完成一步操作后的暂停时间

•  Pause For Audio Annotation 若选中该选框 在暂停的时候会有声音传出 根据速

度的快慢声音的频率会有差别

 Performance 性能

 Accelerated 加速

 Step by step 逐步

 Pause For 暂停时间

 Pause For Audio Annotation 暂停时

有声音



20.6  保存和安装 载入 Actions 动作

20.6.1  Save Actions 保存动作

这个选项主要用于保存自己制作的 Action 因为自己制作的 Action 虽然在面板中暂

时不会消失 但是由于我们经常要 Reset Action 重置动作 经过我们编辑的 Action 面

板经常和原来默认的模式相差较大 重置以后 自己制作的 Action 将不予保存 所以我

们有必要对自己的作品进行保存 保存的步骤如下

1. 选择我们要保存的 Set 序列 或者 Action 动作 然后我们执行 Action 面板下

拉菜单的 Save Action 即可对 Action 进行保存 这是会弹出如图 20-24 的对话框

2. 在这个对话框中我们可以选择保存的位置 名称 注意保存的形式是扩展名为*.AIN
的文件

图20-24  Save Action对话框

20.6.2  Load Actions(载入动作)

载入动作的过程和保存动作的过程是一样的 我们单击面板的下拉菜单的 Load Actions
选项 则会弹出与 Save Action 类似的对话框 从中可以调出 Photoshop 自带的和我们保存

过的 Actions

20.7  Action 的其它操作

1. Clear Actions 清除动作 单击该选项 可以清除当前面板上的所有 Actions
2. Replace Action(替代动作) 选择该选项 我们可以用载入的动作序列替代现在面板

上的动作序列



3. Reset Actions(重置动作) 将 Action 面板上的 Actions 恢复到 Photoshop 默认的模式

本章小结本章小结本章小结本章小结

本章我们介绍了 Action 面板的使用 包括建立新的动作 编辑和使用动作等一系列

的操作 通过对 Action 面板的详细介绍 相信用户对 Action 的使用已经有了一定的心德

由于这是英文版的 对于外语水平不高的用户来说这可能是一个小小的障碍 我们在本章

对一部分的 Action 动作 做了翻译 用户可以参考使用 通过经常的练习 我们会很快

掌握 Action 的使用的



第二十一章  Layer 层 面板

有许多 Photoshop 爱好者将 Layer 层 面板称为 Photoshop 的灵魂 这个比喻虽然有

点夸张 但由此我们就知道了 Layer 层 在 Photoshop 图像编辑中所占的重要地位 当

你学到一定的程度后 如果能够尝试不用图层进行编辑的话 你就知道图层对你的创作是

多么重要了 这一点相信大多数老用户都体会过 但功能强大的 Layer 层 面板并不难

学 对刚入门的爱好者来说 它也不会成为学习的障碍 随着学习的深入 我们就会发

现 Layer 层 面板不仅只能把自己的照片和明星或者自己喜欢的人的照片拼到一起

这只是的它功能的一小部分 通过学习我们能做出许多更美丽的效果

层可以将一个图像中的各个部分独立出来 然后可以对其中的任何一个部分进行处

理 而且这些处理不会影响到别的部分 这就是图层的强大的功能 我们还可以将各个图

层通过一定的模式混合到一起 从而得到许多千变万化的效果 在 Layer 面板上 我们能

进行图层的顺序调换 图层的效果处理 图层的新建和删除等一系列的操作 Phtotshop6.0
除了沿用老版本的所有功能外 还增加了许多新的功能 下面我们就来看一看 Phtotshop6.0
的 Layer 层 面板的功能

21.1  Layer 层 面板基本功能介绍

图21-1  Layer 层 面板图

如图 21-1 是 Layer 层 面板的页面 学过 Photoshop5.0/5.5 的用户会发现 面板上

增加了好几项功能 在这一小节中我们现初步掌握面板上的各个选项的用法 在下一节我

们将举例说明各个选项的技巧 下面我们来了解一下面板的基本功能

•  A Lock 选项 这个选项是用来锁定当前正在编辑的图层和图像的透明区域 锁

定的意思就是使得该图层处于无法编辑的状态 希望用户在使用过程中注意一点



Lock 锁定 这一行的选项对背景是无效的 所以当你刚打开一幅图时 这里的

命令是不可用的 这时 我们可以双击该图层的在面板中的小缩略图 将背景变

为一个层后才是可以使用的

•  B 表示图层的混和模式 模式的种类我们将在稍后提到 我们可以根据需要选

择所需的模式 这些模式在我们以后的学习中将会用到很多 希望用户稍加注意

•  C 锁定选项 锁定当前正在处理的层的透明区域不受处理

•  D 历史画笔图标 图标所在的图层是当前正在编辑的图层 在操作时 每张图

像只能有一个这种图层 如果想同时处理两个或者两个以上的图层 则可以在该

图层的历史画笔图标位置单击即可 则在该位置出现链接的标志 它能使该图层

和历史画笔图层一起接受操作的效果 即如果两个图层链接在一起 操作时所施

加的影响同时作用到链接的两个图层上

•  E 表示该图层是否可见 是否在视野内 如果你想看其它图层的效果 可将该

图层的眼睛图标点去即可

•  F 对当前图层加入 Style 风格 它实际就是在它打开的窗口中设定的你所需要

的参数 对图层做一些效果处理的总和 这一点在制作 Style 风格 时 相信大

家已经有所体会了

•  G Mask 蒙版 这是一个很重要的功能 它一般是将选区外的图像部分都保护

起来 我们就可以在需要处理的地方尽情施展才能了 在操作完之后去掉蒙版就

可以了

•  H 这是一个新增加的功能选项 单击它可以新建一个 Set 序列 就相当于一

个文件夹 把你暂时不需要编辑的图层都放入其中 也可以将某一类图层放入其

中 编辑时点击该 Set 序列 左边的小三角形 选择要编辑的图层即可

•  I 选中它则是固定当前的编辑图层 在以后的编辑过程中 它不能被移动

•  J 单击它即打开 Layer 层 面板的属性菜单

•  K 图层的不透明度 拖动滑杆或者直接输入数值可以控制图像的Opacity 不透明度

•  L 锁定选项 选中它 可以保证当前的图层或者 Set 序列 处于完全锁定状态

除了复选它之外 任何操作对它都无效

•  M 表示该层是当前处理层 这时图层在面板中的小缩略图四周是彩色的

•  N 删除图层 单击面板中的图层的小缩略图 拖到该图标上就可以将它删除了

•  O 新建一个图层 单击它是新建一个空白的图层 而如果单击面板上已有图层

的小缩略图 并拖到该图标上 则是将该图层复制 达到一个复制的图层

•  P 新建填充或者调整图层 打开它的菜单有许多选项可供选择 在窗口中设定

参数就能得到许多效果较好的图层

21.2  Layer 层 面板选项详解

一下子接触到这么多的选项 是不是有点手忙脚乱 没关系 下面我们就 Layer 层

面板部分比较难的选项做一些扩展 通过一些简单的操作 帮助用户以最快的速度掌握不



同的选项的功能

21.2.1  Layer Blend Mode 图层的混合模式

首先我们来看一看图 21-2 中的 Normal 通常 这一选项 使用这个选项时 一般和

Opacity 不透明度 选项配合 Opacity 不透明度 可以改变当前编辑图层的透明度

产生特殊的效果 打开它的下拉菜单 则出现如图 21-2 的窗口 依据窗口中的选项我们

可以对图层进行一系列的处理 每种不同的模式会产生不同的效果

               
                  图21-2  图层模式选项 英          图21-3  图层模式选项 汉

假设有一个层处于一个背景之上 现在讨论一下各种模式的异同

•  Normal 正常 它是系统默认的模式 当 Opacity 不透明度 为 100% 这种

模式没有什么效果 只是图层将背景覆盖而已 选择 Opacity 为一个小于 100%的

值 则图层变得露出背景

•  Dissolve 溶解 当 Opacity 为 100%时 它不起作用 因此必须和 Opacity 不

透明度 配合 当 Opacity 固定为一个小于 100%的值 这时图层逐渐溶解 即其

部分像素消失 而且消失的位置是随机的 并在溶解的部分显示背景 形成两个

层交互的效果

•  Multiply 正片叠底 这个选项可以产生比图层和背景的颜色都暗的颜色 用这

个模式可以制作一些阴影效果 这里有一个常识 黑色和任何颜色混和还是黑色

而任何颜色和白色叠加 得到的还是该颜色

•  Screen 屏幕 有人说它是 Multiply 模式的逆运算 因为它的使用将是两个图层

的颜色越叠加越浅 如果你选的是一个浅颜色的图层 那它就相当于一个对背景

漂白的漂白剂 这就是说 如果你的图层是白色的话 在这种模式下 背景的颜

色将变得非常模糊

•  Overlay 叠加 其效果相当于对图层同时使用 Multiply 和 Screen 两种操作 加



深了背景颜色的深度 并且覆盖了背景上浅颜色的部分

•  Soft Light 柔光 它类似于将点光源发出的漫射光照到图像上 使用这种模式

会在背景上形成一层淡淡的阴影 阴影的深浅与两个图层混和颜色的深浅有关

总之 该模式的效果是神秘而美丽的

•  Hard Light 强光 这种模式可以说是 Soft Light 的一种更为剧烈的模式 颜色和

Soft Light 相比 或者更为浓重 或者更为浅淡 这取决于图层上的颜色的亮度

•  Color Dodge 颜色减淡 使得图层的亮度增加 使得背景好像被漂白了一样

这个模式和 Screen 相类似 但它的效果比 Screen 更加明显 由于图层各部分的颜

色不同 它有时会得到一些意想不到的效果

•  Color Burn 颜色加深 这个模式将会获得与 Color Dodge 相反的效果 图层的

亮度减低 色彩加深

•  Darken 变暗 在这种模式下 画面显示的颜色或者物体 都是两个层中颜色比

较深的覆盖颜色浅的 我们在选取一些图像时 边缘经常会有一些淡淡的 毛边

这时我们可以用这个模式 选择一种介于主图像颜色和 毛边 颜色之间的颜色

对其进行描绘 就可以精确选出我们需要的图像来

•  Lighten 变亮 这种模式仅当图层的颜色比背景的颜色浅时才有用 图层的浅

色将覆盖背景的深色部分

•  Difference 差值 这种模式是将图层和背景的颜色相互抵消 产生一种新的颜

色效果

•  Exclusion 排除 这种模式会产生一种图像反相的效果 我们可以称之为 Difference
模式的遍体

•  Hue 色相 该模式似乎只对灰阶的图层有效 彩色图层在这种模式下会凭空消

失

•  Saturation 饱和度 这个模式用户可以自己动手试一试 当图层为浅色时 我

们会得到它的最大效果

其它两项用户也可以自己动手试一试 这里不在赘述了

现在我们就这个菜单举两个例子 首先我们打开如图 21-4 图 21-5 两幅图像 为什么

我们要选两个图呢 虽然这项功能对当前处于编辑状态的图层进行 但如果你在单一图层

又没有背景的图像上进行操作的话 一般来说 在图像上得不到什么好的效果 我们先打

开其中的一个图片 1 双击该图层的小缩略图 则将出现如图 21-6 的对话框 在这个对话

框中 我们可以选择图层在面板上显示 Color 颜色 和 Mode 模式 也可以选择图层

的 Opacity 不透明度 然后我们单击 OK 即可将背景转化为图层 转化后的背景默认

为透明

然后再打开图片 2 同样将背景转化为层 现在我们有两个层了 接下来要做的就是

将它们放到同一个图层中 我们可以单击图片 1 的 Layer 面板中图层的小缩略图 将其拖

到图片 2 的画面上就得到我们需要的两个图层的图像了 这时其中的一张图层是看不见

的 或者我们将图像 1 整个拷贝后粘贴到图像 2 中 这时图像 2 将会自动为图像 1 创建一

个新的图层 所以两种操作的结果是一样的 现在我们选择图 21-22 菜单中 Multiply 正

片叠底 选项 并将图层 1 的不透明度设为 66% 则将得到如图 21-7 的效果



     

                 图21-4  图片1                                图21-5  图片2

图21-6

图21-7

从以上这个例子可以看出 这虽然是个比较老的功能 但它的用途的确不小 两个图

层很好的融合在一起 还别有一种特殊的风格 同样我们可以尝试不同的模式 设定参数

后它们将得到不同的效果

下面我们将就 Lock 锁定 所在行的选项举一个简单的例子 如图 21-8 我们打开

一幅图像 然后先打开 History 历史 面板 在右上角的下拉菜单中选择 New Document
新文档 则将出现两个如图 21-8 的图像 在其中的一个图层面板上选中 Lock 行的最

右边的选项 即锁定对图层的所有操作 我们在未锁定的图像上用画笔画如图 21-9 的线



条 在对图 21-8 执行相同的操作 可以发现 它没有变化 读者可以尝试其它操作 也

必然得不到任何变化的 我们由此就可以体会 Lock 锁定 选项的用途了 我们在含有

文本的图像中也可以体会到锁定透明区域的好处 在本书后面的例子中会涉及到这方面

的

     

                   图21-8                                         图21-9

21.2.2  Layer面板弹出菜单

现在我们来学习 Layer 层 面板的弹出菜单 点击右上角的小三角形 就可得到如

图 21-10 的对话框 从上图我们可以看出 菜单上的选项和面板的一些选项的功能是类似

的 这种情况在 Photoshop 中很多 许多功能菜单弹出的方式通常都有许多种 有的是快

捷键 有的是图标 我们一般都可以根据需要用不同的方式调出 在这个菜单中 新增的

选项有 New Layer Set 新建图层序列 New Set From Linked 新建链接层序列 和 Lock All
Linked Layers 锁定所有链接的层 下面我们简要介绍一下各个选项的功能

图21-10  Layer 层 面板的弹出菜单

1. New Layer 新建图层

选择这个命令后 就会出现前面提到的如图 21-6 的窗口 设定参数以后 就会生成

一个新的图层 当然我们还可以直接点击面板上的新建图层的图标 得到 那么新建图

层的参数就是面板的参数 通常我们还会用到另一种创建图层的方法 这会在 File 窗口的



章节内提到 即执行 File >Layer Via Copy 将原图层中的某一部分单独拷贝建立一个新

的图层

2. Duplicate Layer 复制图层

我们选择 Duplicate Layer 时 将得到与当前在编辑图层完全一样的一份拷贝 当然

我们也可以将该图层的小缩略图直接拖到面板上右下角的 New Layer 的图标上即可 这个

选项有利于我们对一些操作效果进行快速地保存 因为拷贝后的图层可以进行下一步的操

作

3. New Layer Set 新建图层序列

我们在介绍面板上的选项时已经提到过了 单击 New Layer Set 新建图层序列 后

将弹出如图 21-11 的界面 我们可以为这个新序列取一个名字 更改它在面板上的显示颜

色 设定图层的 Mode 模式 和 Opacity 不透明度 之后单击 Ok 关闭窗口就得到新的

Set 序列

图21-11

建立层序列的目的是将同一类的图层放到一个起名的 Set 序列 中 在得到序列后

我们可以通过拖动将图层放到 Set 序列 中 也可以将 Set 序列 中的图层拖到序列外

如果我们想要对 Set 序列 中的所有的图层实行同一个混和模式的操作时 也可以使用

这个功能 我们将新建图层序列前后 Layer 面板作比较 椭圆形就是我们制作的 New Layer
Set 新图层序列 如果我们要将某图层放入这个 Set 序列 中 只需要单击该图层的

小缩略图 将其拖入 Set 序列 文件夹中就可以了

       

        图21-12 A   新建图层序列前的面板        图21-12 B   新建图层序列后的面板

4. New Set From Linked 新链接层序列

选择它可以将所有链接在一起的图层合并到一个 Set 序列 中 构成一个新的 Set 序

列



5. Lock All Linked Layers 锁定所有的链接层

它可以使所有处于链接状态的图层被锁定 这个选项一般用于需要保护的图层 处于

这种状态的图层不能被做任何编辑 在你完成对其它图层的处理后 你可以复选面板上的

Lock 锁定 行选项的最后一项就可以去掉锁定

6. Layer Properties 图层的属性

打开面板 弹出菜单的该项 则弹出如图 21-13 的窗口 我们将该图层重命名 也可

以更改图层的小缩略图在面板中的显示颜色 完成选择后 单击 OK
7. Palette Options 调板选项

打开该菜单 我们可以改变图层在面板中显示的缩略图的比例的大小 打开如图 21-14
的窗口 选中图最上方的 None 则图层在面板上以完全文本的模式表示 越往下显示的

比例越大 但要注意的是 这是以牺牲一部分内存空间得到的 如果你的计算机的性能不

是特别优良的话 建议选择适当的小缩略图就可以了 这样不仅可以保证你的计算机不死

机 还会保证你的计算机能够以正常的速度处理图像

          

                        图21-13                                       图21-14

8. Merge Visible 合并可见层

合并可见层就是将所有可见的图层都合并为一层 这个操作可以使已经完成制作的图

层合并 节省空间 因为每个图层的大小都几乎和一张图的大小差不多 虽然 Photoshop
在设计时允许建立 99 个层 但一般的机器到十个层以上基本都承受不了了 在执行

MergeVisible 合并可见层 时 我们首先应该把不想参加合并的图层隐藏起来 然后选

中需要合并的图层 即可执行该命令

9. Flatten Image 压平图像

当我们完成对所有的层的编辑之后 即可选择该项命令 Flatten Image 压平图像

命令执行的结果是图像中所有的图层都融合到背景中去 如果在选择这个命令时 弹出如

图 21-15 的窗口 这表示你的层面板中还有隐藏的图层 如果你决定抛弃不可见图层 则

单击 OK 即可 如果不想丢掉苦心制作的图层 则用 Cancel 回到主页面 使该图层可见

后再执行命令



图21-15

21.3  Adding Layer Style To Current Layer

对当前图层加入风格

我们将 Layer 面板中的这一选项单独列出一章 是因为这个选项是一个新的内容 在

这里面我们会学到许多新的知识 在 Layer 面板下方的第一个图标 打开它的下

拉菜单 则可见到如图 21-16 的窗口

        
图21-16

实际上 图 21-16 横线下面的选项都是 Blending Options 混和选项 的子菜单 从

图 21-17 的矩形框内我们可以知道这一点 我们可以任选一个选项进入图 21-17 的窗口

当我们发现选择的选项制作效果不佳时 我们可以直接在窗口的左边矩形框内更改选择

例如我们选择其中的一个 如 Bevel And Emboss 斜面和浮雕 则出现如图 21-17 的窗

口

这时你可以逐一尝试各个选项的功能 你就会发现 所有选项的窗口都有如图 21-18
的外壳 为了更好地全面地学习这个这一部分知识 下面我会就根据图 21-18 这个外壳对

它的基本功能一一介绍 在这个面板中间的部分是不同选项时将出现的窗口 A B C
是不同选项决定是否能弹出窗口

 Blending Options 混合选项

 Drop Shadow 投影

 Inner Shadow 内阴影

 Outer Glow 外发光

 Inner Glow 内发光

 Bevel And Emboss 斜面和浮雕

 Satin 绸缎

 Color Overlay 颜色覆盖

 Gradient Overlay 渐变覆盖

 Pattern Overlay 图案覆盖

 Stroke 描边



图21-17

图21-18

21.3.1  Style 风格

这个选项可以对当前的图层进行风格化 在这里我们可以选择已有的风格和自己制作

的风格 关于风格的使用问题 我们在 Style 一节已经介绍过了 不太清楚的用户可以回

头复习一遍 在 Layer 面板中这个选项的使用我们通过图像加以解释 如图 21-19 在我

们选择好合适的 Style 之后 我们只要单击 OK 就可以执行该 Style 的效果了 即将这些效

果加到我们目前正在编辑的图层上 如果那是你自己制作的一个对图层实施的效果处理操

作的话 你也可以将它存储成为一个新的 Style



图21-19

21.3.2  Default Blending Options 默认混和选项

若对图像实行效果作用 这是它的默认的模式 由于 Layer 面板的窗口的外壳相似

所以我们只列出与外壳图的 A B C 部分相关的窗口 如图 21-20

图21-20

•  Blend Mode 混和模式 我们在学习图层基础知识的时候已经学过了 有兴趣的

话可以回头看一看

•  Fill Opacity 填充不透明度 可以改变填充图层的不透明度

•  Channel 通道 在三个复选框中 我们可以选择参加高级混和的 R G B 通道

中的任何一个或者两到三个 一个也不选的话也可以 但一般得不到理想的效果



至于通道的详细的概念我们将会在以后的 Channel 通道 面板中加以阐述

•  Knockout 脱模 这个选项可以控制图层色调的深浅 有三个下拉菜单 在图上

已经注明 用户可先进行尝试 它们的效果各不相同

•  Blend Interior Effects As Group 混和内部效果为组 这个选项是将本次作用到图

层的内部效果并到一个组中 在下次使用的时候 出现的窗口的默认参数即现在

的参数 关于 Group 的概念 我们在 Layer 一章中已经谈过

•  Blend Clipped Layers As Group(混和修剪层为组) 将修剪的图层合并到同一组中

关于剪贴层的概念和用法请大家参考 File 一章

•  Blend If 将层的该颜色混和 它有四个选项 分别是灰 红 绿 蓝 我们可以

根据需要选择适当的颜色 这个选项得到的效果一般会具有梦幻的感觉 可以达

到意想不到的效果 对于有很强的好奇心的用户来说 一定要亲自操作一次才会

有深刻的体会 不信的话 你可以一试

•  细心的你一定已经发现 This Layer 当前层 和 Underlying Layer 下一层 的

颜色条两边都是由两个小三角形组成的三角形 这时调整该图层的色彩的深浅的

如果直接用鼠标拖动的话 我们只能将整个三角形拖动 将没有办法缓慢变化图

层的颜色深浅 如果我们在按住 Alt 键后拖动鼠标 则可以拖动在右边的小三角

形 达到缓慢变化图层颜色深浅的目的 即得到大椭圆所示的画面 用同样的操

作 我们可以对其它三个三角形进行调整

21.3.3  Drop Shadow 投影

Drop Shadow 投影 这个选项能给图层元素配加一个阴影 选中该项目则弹出如图

21-21 的窗口

图21-21

我们将主窗口的 A 部分提出 则有如图 21-22 的页面 而如果我们将 B 部分提出

则有如图 21-23 的界面



    

图21-22

在图 21-22 中的 Blend Mode 混和模式 这一选项与以前接触的混和模式稍有不同

以前我们选择的是以背景为对象 而现在我们选的则是以模式选框后边的颜色作为背景

当然 我们可以根据自己的喜好选择颜色作为效果 具体颜色的选择我们在 Color 颜色

面板那一节中已谈过了 图中的 Opacity 不透明度 也是以前的内容 这里不再赘述

接下来我们对图 21-22 中的各项进行解释

1. Angle 角度 这时指灯光的角度 它是用来设定亮部和阴影的方向 即阴影的方

向会随着角度的变化而变化 一般是角度的反方向产生阴影

2. Use Global Angle 使用全角 使用这个选项时 所产生的光源是作用于同一张图

像中的所有的图层 如果我们不选中该项的话 产生的光源只使用于当前编辑的图层

3. Distance 阴影距离 这个选项控制着阴影的距离 你可以尝试将它调到极大值

这时我们就可以清楚地看清该选项的功能了

4. Spread 扩展 扩展就是对阴影的宽度作适当细微的调整 我们可以用测试 Distance
距离 的方法检验它

5. Size 大小 此选项控制阴影的总长度 加上适当的 Spread 参数 它将会产生一

种逐渐从阴影色到透明的效果 它就好像将固定量的墨水泼到固定面积的画布上 但它不

是均匀的 而是由全 黑 到透明渐变

图 21-23 是 Drop Shadow 投影 窗口的 B 部分

图21-23

1. Anti-aliased (消除锯齿) 这使得在固定的选区作一些变化时 变化的效果不至于显

得很突兀 很突然 使得效果过渡变得柔和

2. Noise 噪音 它使得投影有点斑点化 有种噪音的感觉

 Blend Mode 混和模式

 Opacity 不透明度

 Angle 角度

 Use Global Light 使用全角

 Distance 阴影距离

 Spread 延伸 扩展

 Size 大小

 Quality 质量

 Contour 轮廓线

 Anti-aliased 羽化

 Noise 噪音效果

 Layer Knocks Out Drop
Shadow 破碎的层投影



3. Contour 轮廓线 用这个选项我们可以使图像产生立体的效果 也可以单击窗口

的下拉菜单 则弹出如图 21-24 的窗口 不同的选择将会产生不同的轮廓线 我们可以根

据图 21-48 的图形使用恰当的模式 如果你还是觉得这里的模式太少的话 打开右上角的

下拉菜单 如图 21-25 所示

图X 24

  

图21-25

在这里我们着重学习怎样新建一个轮廓线 而关于轮廓线的其它操作基本上和新建轮

廓线相类似 而且我们在前面已经接触到许多类似的菜单可以参考领会

双击如图 21-23 椭圆内的图标 则将会弹出如图 21-26 的窗口

•  Preset 预置 从它的下拉菜单中 我们可以先选择比较接近我们需要的轮廓线

然后在上面添加锚点 即用鼠标在曲线上单击 就会出现如图 21-27 的窗口 然

后我们用鼠标单击并拖动锚点 则会得到一条曲线 其默认的模式是平滑的曲线

我们可以选择 Corner 角度 这时我们得到的是一张线条过度尖锐的图 还有

一点需要注意的是 锚点不是唯一的 我们应该根据需要选择数目

•  Input 输入 和 Output 输出 输入指的是在图像的该位置原来的色彩相对数

值 输出指的是通过这个 Contour 轮廓线 的处理后得到的图像在该处的色彩

相对数值

 New contour 新建轮廓线

 Reset Contours 重置轮廓线

 Load Contours 载入轮廓线

 Save Contours 保存轮廓线

 Replace Contours 替代轮廓线

 Rename Contours 重命名轮廓线

 Delete Contours 删除轮廓线

 Text Only 单一文本

 Small Thumbnail 小缩略图

 Large Thumbnail 大缩略图

 Small List 小列表

 Large List 大列表



图21-26

图21-27

•  Corner 角度 在这个选框中 我们可以确定我们的 Contour 曲线是圆滑的还是

尖锐的 两种模式得到的效果是不一样的 可以尝试将它们的效果图进行比较

在完成对曲线的制作以后 单击 New 新建 则将会弹出如图 21-28 窗口

图21-28

在这个窗口中 我们将自己的作品命名 单击 OK 就完成制作了



21.3.4  Inner Shadow 内阴影

Inner Shadow 可使得图层元素看起来像是陷入背景似的 像素的设置方法同 Drop
Shadow 投影

打开该选项 则出现如图 21-29 的界面

图21-29  Inner Shadow对话框

比起 Drop Shadow 投影 来说 Inner Shadow 内阴影 的 B 部分的所有功能在 Drop
Shadow 投影 中都涉及到了 用户可以参考上一节学习 而 A 部分则稍有不同 我们

现在来看一看这一部分 如图 21-30

图21-30

我们可以看出 A 部分只是将原来的 Spread 扩展 改为现在的 Choke 阻塞 所

以我们重点介绍一下 Choke 这是一个和 Spread 扩展 相似的功能 但它是 Spread 的

逆运算 Spread 是将阴影向图像或选区的外面扩展 而 Choke 则是向图像或选区的里边扩

展 它们得到的效果图极为类似 在精确制作时可能会用到的 如果我们将两个选框都选

中的话 并分别对它们进行参数设定 则会得到一些比较奇特的效果

 Blend Mode 混和模式

 Opacity 不透明度

 Angle 角度

 Use Global Angle 使用全角

 Distance 阴影距离

 Choke 阻塞

 Size 大小



21.3.5  Outer Glow 外发光

Outer Glow 外发光 加一个任意颜色的辉光围绕在图像元素的边缘之外 为了看

到效果 可以键入一个较高的数值 画激光或幻影之类的形象 非常有用 它们得到的效

果图极为类似 在精确制作时可能会用到的

1. 窗口的 A 部分

窗口的 A 部分如图 21-31 其中 Blend Mode 混和模式 和 Opacity 不透明度 以

及 Noise 噪音 的用法见本章前面部分 我们重点讨论最下边的颜色条 这里有两个复

选框 选中左边的选项则阴影的颜色为单一的该颜色的变化 需要注意的是两个选框是互

相排斥的 只能选择其中的一个 在选中第二个选框时 我们得到的是色谱条 它既可以

是单色的也可以是多种颜色共同变化得到的 打开下拉窗口 则得到如图 21-32 所示的界

面 我们可以从中选择合适的渐变色谱条

                        图21-31                              21-32

如果没有你满意的色谱条的话 你可以打开右上角的下拉菜单 得到如图 21-33 的窗

口 并从中选择适当的选项

         

图21-33

仔细观察图 21-33 可以知道 菜单分三个区 其中第一个区是重置和替代渐变 重置

就是回到原来默认的几个渐变模式 在这之前一定要把自己制作的渐变模式进行保存 否

则将会被丢弃 而替代则是用新的渐变模式替代原来的模式 第二个区是管理菜单里的渐

 Reset Gradient 重置渐变

 Replace Gradient 替代渐变

 Text Only 单一文本

 Small Thumbnail 小缩略图

 Large Thumbnail 大缩略图

 Small List 小列表

 Large List 大列表

 .GRD 色谱条优化选项



变选项的小缩略图的显示模式 选择适当的模式即可 第三个区是对面板进行优化的选项

这些选项我们也可以通过 Load 载入完成 载入以后 我们会有更多的渐变模式可供选

择 我们应该逐一尝试 找出它们的异同点 以后就可以在创作中用到它们了

在 Photoshop 6.0 中 几乎每个面板上都有许多选项是可以自己制作的 这给了广大

的爱好者以更大的发挥空间 使得他们不再拘泥于固定的模式 做出几乎千篇一律的作品

这对于渐变模式也不例外 我们用左键单击图 21-31 下方的色谱条 则会弹出如图 21-34
的窗口 在这个窗口中 我们可以在已有的渐变模式的基础上修改 得到一些全新的渐变

模式 然后对它进行新建 命名和保存 得到在以后的创作中可以应用的渐变模式

图21-34

•  Preset 预置 在这个小窗口中 我们打开右上角的下拉菜单 则将得到如图 21-33
的界面 其功能可参见前面的内容

•  Name 命名 我们可以根据采用的颜色或者其它依据进行命名 最重要的当然

是容易记住 以后用到的时候可以很快地查到 在这一项中 我们还可以对已有

的渐变模式重新命名

•  Gradient Type 渐变类型 这个选项的下拉菜单有 Solid 固体 和 Noise 柔

软 两项 图 21-34 是 Solid 部分的窗口 Noise 的窗口与之大不相同 我们将会

稍后提到

•  Smoothness 平滑 它的数值越大 色谱条的不同颜色的变化过程越柔和 不会

显得突兀 当然 有时候突兀也会得到一些意想不到的效果 改变平滑度可以拉

动滑块或者直接输入数值

单击色谱条上方的颜料桶是不透明度 我们可以从 Opacity 不透明度 选项上看出

色谱条该点的透明度信息 拖动该颜料桶 我们可以使得它拖过的色谱条具有相同的参数

如果我们先单击该颜料桶 再在我们选择的一个地点单击 则该地点就具有了相同的参数

当然 我们也可以直接在 Opacity 的的框内输入需要的数值 色谱条的下方是颜色在色谱



条上的相对位置 以百分数表示 更改参数或者设置的方法与改变不透明度的方法相同

图 21-35 是图 21-33 的色谱条经过一系列的调制得到的 如果觉得某些点的设置不合理的

话 我们先单击该颜料桶选中 再单击右下角的 Delete 删除 即可

图21-35

图 21-36 是 Noise 选项的窗口 现在我们解释一下各项的功能

图21-36

•  Roughness 硬度 调整渐变的硬度 硬度越大则得到的渐变模式中 各种颜色

之间的界限越清楚 最后就成了一张类似光谱的图

•  Color Model 颜色模式 在这个选项的下拉菜单中 我们可以选择 HSB Lab
以及 RGB 三种颜色模式 通过每种基本色两端的滑块 我们可以调整各种颜色

的比例 直至达到合适的色谱条

•  Restrict Colors 限制溢出 这个复选框可以控制颜色的溢出 我们使用的颜色

中有些是电脑或者打印机无法分辨的 选中这个选框 则不会出现溢出这种情况

•  Add Transparency 加入透明噪音 对这个渐变模式加入透明的噪音 使之产生

颗粒的效果

•  Randomize 随机化 使 Options 选项 中 两个选项产生的效果随机化 其效

果比较均匀

2. 窗口的 B 部分

窗口的 B 部分如图 21-37 窗口中的各个选项的含义如下

图21-37



•  Technique 技术 即边缘元素的模型 有 Softer 柔和 和 Precise(精确)两种

Softer 的边缘变化比较清晰 而 Precise 的边缘变化比较模糊 因而看起来似乎更

好

•  Spread 扩展 即边缘向外边扩展 与前面提到的阴影中的 Spread 选项的用法

类似

•  Size 大小 这个选项可以控制阴影面积的大小 它的变化范围是 0 250Px 像

素

3. 窗口的 C 部分

   

图21-38

•  Contour 轮廓线 我们在前面一节中已经介绍了它的使用

•  Range 轮廓线运用的范围 轮廓线运用的范围 其数值越大 一般将会导致效

果越不明显

•  Jitter 光的随机化渐变 这个选项可以控制光的渐变 数值越大 图层阴影的效

果越不清楚 且变成有 Noise 噪音 的效果 数值越小 就会越接近清楚的阴

影效果

4. 举例

讲了这么多枯燥的理论 现在我们来举个例子

图 21-39 和 21-40 分别是经过 Outer Glow 外发光 处理前后的图像 我们可以从比

较中领会这个选项的功能 在这个例子中 我们还运用了通道进行精确地选择 这将会在

以后的图层一节中提到

     
                  图21-39                                         图21-40

 Quality 质量

 Contour 轮廓线

 Anti-Aliased 羽化

 Range 轮廓线运用的范围

 Jitter 光的随机化渐变



21.3.6  Inner Glow 内发光

图21-41  Inner Glow对话框

观察图 21-41 我们会发现 Inner Glow 窗口和 Outer Glow 外发光 的窗口几乎是

完全一样的 只是 Outer Glow 外发光 窗口中的 Spread 选项变成 Inner Glow 内发光

中的 Choke 阻塞 因此这是两个刚好相反的选项 Outer Glow 外发光 得到的阴影是

在图层的边缘 在图层之间看不到 Effect 效果 的影响 而 Inner Glow 内发光 得到

的效果只在图层内部 在图层的透明区域也是不可见的 就是得到的阴影只出现在图层的

不透明的区域 图 21-42 和 21-43 即是两者的对比

      

图21-42                                  图21-43

21.3.7  Bevel And Emboss 斜面和浮雕

打开该选项 则会出现如图 21-44 的窗口



图21-44  Bevel And Emboss对话框

下面我们将逐一介绍窗口的各个部分

1. 斜面和浮雕窗口的 A 部分

 

图21-45

(1) Style(风格) 这里提到的风格和以前提到的不是同一个类型 在它的下拉菜单中

共有五个模式 它们分别是内斜面 外斜面 浮雕 枕状浮雕 描边浮雕五种 运用它们

将会得到不同的效果 我们将在后面的举例中学习和领会它们之间的区别

(2) Technique 技术 打开它下拉窗口 有三个选项 分别是 Smooth 平滑 Chisel
Hard(硬雕刻)和 Chisel Soft(软雕刻)

•  Smooth 平滑 这种方法得到的图层效果的边缘过渡比较柔和 也就是它得到

的阴影的边缘变化不尖锐

•  Chisel Hard(硬雕刻) 这个选项将产生边缘变化明显的效果 比起 Smooth 平滑

来 它产生的效果立体感特别强

 Smooth 平滑

 Chisel Hard 硬雕刻

 Chisel Soft 软雕刻

 Outer Bevel 外斜面

 Inner Bevel 内斜面

 Emboss 浮雕

 Pillow Emboss 枕状浮雕

 Stroke Emboss 描边浮雕



•  Chisel Soft 软雕刻 与硬雕刻类似但是它的边缘的色彩变化要稍微柔和一点

(3) Depth 深度 这是一个控制效果的颜色深度的选项 其数值越大 则得到的阴

影颜色越深 反之 数值越小 得到的阴影颜色越浅

(4) Size 大小 它控制着阴影面积的大小 拖动滑块或者直接更改右边框内的数值

就可以得到合适的效果图

(5) Soften 柔化 拉动滑块可以调节阴影的边缘过渡 数值越大的话 其边缘过渡

越柔和

(6) Up 上 和 Down 下 两个选项是用来切换亮部和阴影的方向 如果我们选择

Up 则亮部在上面 反之 我们选择 Down 则亮部在下面

2. 斜面和浮雕窗口的 B 部分

      
                              图21-46 A                             图21-46 B

•  Angle 角度 如果把图中的那个圆当作平面图形的话 那么它决定着灯光在圆

中的角度 中间的那个圆中的 + 符号可以用鼠标移动 它会同时调整 Angle
和 Altitude

•  Use Global Light 使用全角 决定应用于图层的效果的光照角度 你可以定义一

个全角 以应用于图像中所有的图层效果 也可以指定局部角度 仅应用于特定

的图层效果 使用全角可制造出一种连续光源照在图像上的效果

•  Altitude 纬度 如果将图中的圆当作一个地球 那么它就是 + 在地球上的纬

度 也就是灯光在地球上的纬度

•  Gloss Contour 光泽轮廓线 它决定着被编辑的图层的效果的光泽 这个选项的

编辑和使用的方法和前面提到的 Contour 轮廓线 的编辑方法是一样的

•  Anti-Aliased 消除锯齿 见前面章节

•  Highlight Mode 高光模式 这相当于在图层的上方有一个带色光源 光源的颜

色可以通过右边的颜色方块来调整 其调整方法见 Color 颜色 面板章节 它

会使图层达到许多种不同的效果 模式的种类如图 21-46 B
•  Opacity 不透明度 即它可以改变作用层的不透明度

•  Shadow Mode 阴影模式 在这个选项中 我们可以调整阴影的颜色和模式 我



们在右边的颜色方块中改变阴影的颜色 通过下拉菜单改变阴影的模式 其模式

的种类也是如图 21-46 B 所示的几种

3. 斜面和浮雕窗口的小菜单 1 Contour 轮廓线

图21-47

单击 Bevel And Emboss 斜面和浮雕 选项下面的 Contour 轮廓线 注意要点击带

颜色的横条 不要选择前面的复选框 则得到如图 21-47 的窗口 从这个图中可以看出

这里的选项都是以前章节学习过的 这里就不再讲了 有一点要注意的是 我们将它称为

斜面和浮雕效果的小菜单 是因为这个选项只有在已经选中 Bevel And Emboss 选项的情

况下才是可编辑的 对于下面将要提到的 Texture 文本 也是这样的

4. 斜面和浮雕的小菜单 2 Texture 文本

单击 Bevel And Emboss 斜面和浮雕 选项下面的 Texture 文本 则出现如图 21-48
右上角的窗口 下面介绍一下右上角主窗口上各个选项的含义

•  Pattern 图案 在这个选框中 我们可以选择合适的图案 Bevel And Emboss 斜

面和浮雕 的浮雕效果就是按照图案的颜色或者它的浮雕模式进行的 我们可以

随便选择一个图案 那么在预览上就可以看出待处理的图像的浮雕模式和我们所

选的图案的关系了 打开下拉菜单 可将如图中右上角的图案选择面板 我们可

以从中选择合适的图案

•  Snap To Origin 使图案的浮雕效果从图像或者文档的角落开始 在默认的模式下

我们选择该选项是得不到什么效果的

•  打击图标 是将图案创建为一个新的预置 即我们下次使用的时候可以从 Pattern
的下拉菜单中打开该图案

•  Scale 是将图案放大或者缩小 表现在图像上就是浮雕的密集程度 Scale 的变化

范围在 1 1000%之间 我们可以选择合适的比例对图像进行编辑

•  Depth 浮雕深度 通过滑杆 我们可以控制浮雕的深浅 它的变化范围在+1000%
到 1000%之间 正负表示浮雕是凹进去还是凸出来 我们也可以选择适当的数

值填入后边的选框即可

•  Invert 反转 选择该复选框 就会将原来的浮雕效果反转 即原来凹进去的现在

凸出来 原来凸出来的现在凹进去 得到一种相反的效果

•  Link With Layer 和层链接

 Element 元素

 Contour 轮廓线

 Anti-Aliased 消除锯齿

 Range 效果的范围



图21-48  Texture选项窗口

图中下方的是图案的下拉菜单 在这个菜单中我们可以对图案面板进行一些编辑

•  图案的新建 存储 载入和替代等都可以在菜单中完成 在存储等一些操作中一

般都会弹出如图 21-49 的一个对话框 在这个对话框中 我们可以对图案进行命

名 之后 我们单击 OK 即可

图21-49

•  重命名和删除图案 我们在选中图案的前提下单击该选项就可以了 另外 我们也

可以双击该图案 则弹出如图 21-49 的对话框 在这里我们可以对它进行重命名

•  编辑面板上的缩略图 缩略图的模式共有五种 分别是 小列表 大列表 单一

文本 小缩略图和大缩略图 具体的效果我们在实践之后就会清楚地知道了

•  优化图案面板 如果我们觉得面板上的图案太少或者未找到合适的图案的话 我

们可以单击选项 Placrholder.Pat 即可增加一些新的图案 或者也可以 Load 载

入 一些新的图案

21.3.8  Satin 绸缎

这是一个全新的菜单 它产生的效果是将图像变成一种类似绸缎的平滑的样子 在选



定的颜色下面它的边缘会有阴影 一般情况下得到的效果是图像的整个画面的颜色都会比

较黯淡 我们可以通过颜色的调整实现将图像的整体的颜色明朗化

图21-50  Satin的打开窗口

•  Blend Mode 混和模式 它以图像和黑色为编辑的对象 其模式是以前提到的图

层的混和模式 其实两者是一样的 只是 在这里 Photoshop 将黑色当作一个图

层来处理而已

•  Opacity 不透明度 这个选项调整的是混和模式中颜色 图层 的不透明度

其调整可以通过滑杆进行 也可以直接在右边的选框内输入一个数值 其变化范

围是 0 100% 在选择 0 时 我们几乎看不到有什么效果

•  Angle 角度 即光照射的角度 它控制着阴影所在的方向 阴影的方向和它的

方向应该是刚好相反的

•  Distance 距离 它的数值越小的话 在图像上则表现为被效果覆盖的区域越大

即 Distance 控制着阴影的距离 它控制着效果的偏移 这里有一点要注意的是

在 Satin 窗口中 阴影是在图像的内部

•  Size 大小 这个选项控制着实施效果的范围 范围越大的话 效果作用的区域

越大

•  Contour 轮廓线 这个选项我们在前面的效果选项中已经提到过了 这里不再

重复 用户可以回头复习一下 再看这一部分会有较大的帮助 关于该选项的两

个下设选框我们也一并略去

为了给大家一个形象的认识 我们在下面给大家举个例子 图 21-51 是原图像 而图

21-52 则是我们用 Satin 绸缎 对它进行处理后的图像 从它们的对比中我们可以了解这

个效果选项的功能 其中参数设置的技巧 用户可以通过实践学习



    

              图21-51  原图像                              图21-52  Satin效果图像

21.3.9  Color Overlay 色彩覆盖

图21-53  Color Overlay打开窗口

我们单击图标 打开其中的选项 Color Overlay 色彩覆盖 则会弹出如图 21-53
的窗口 实际上 这个窗口是比较简单的 它是将颜色当作一个图层 然后再对这个图层

施加一些效果或者混和模式 就得到所谓的 Color Overlay 颜色覆盖 的效果 下面我们

举个例子 说明它们可以在设置相同的参数之后可以得到相同的效果

1. 我们打开如图 21-54 的图像 将图像设置为一个层 然后单击图标 新建一个图

层 这时我们得到的面板如图 21-55 所示

2. 我们现在对对图层填充红色 则得到如图 21-56 的图像 这时图像上全是红色 原

来的背景层是不可见的 这时我们可以在图层面板上对图层施加如图 21-56 的变化 则会

得到如图 21-57 的效果



      

                     图21-54  原图                                  图21-55

      

                图21-57  处理后的图像                               图21-56

3. 现在我们利用 Effects 来完成这一过程 我们将原图转化为一个层之后 打开 Color
Overlay 窗口 在窗口中我们可以设置模式为 Overlay Opacity 为 100% 如图 21-59 则

得到如图 21-58 的效果 可以看出 图 21-58 和 21-56 的图像效果是一模一样的 从对比

中我们就可以知道通过层的 Effect 得到的效果和通过层面板得到的效果是一样的

      

             图21-58  通过Effects处理的图像                          图21-59



21.3.10  Gradient Overlay 渐变覆盖

这是一个很有用的工具 利用它我们能制作出一些梦幻的效果 单击图标 我们打

开如图 21-60 的窗口

图21-60  Gradient Overlay打开窗口

•  Blend Mode 混和模式 这些模式的选择可以根据我们在图层面板中提到的知识

进行设定

•  Opacity 不透明度

•  Gradient 渐变 我们使用这个功能对图像做一些渐变 Inverse 选框表示将渐变

的方向反转

•  Style 风格 在窗口的下拉菜单中有五个选项 分别是如图 21-61 所示

               

图21-61  Style类型

•  Angle 角度 利用这个选项 可以对图像产生的效果做一些角度变化

•  Scale 范围 它控制 Effects 影响的范围 通过它我们可以调整产生 Effects 的区

域的大小

 Linear 线性的

 Radial 放射性的

 Angle 角

 Reflected 反射的

 Diamond 钻石



关于 Gradient 渐变 选框 我们在前面的内容中已经详细做了介绍 这里不再重复

而对于 Style 下设的五种风格 我们将通过例子加以解释 图 21-62 是原图像 图 21-63
到 21-67 是我们用 Gradient Overlay 得到的效果图 其参数设定如下 Blend Mode Screen
Opacity 100% 选中 Align With Layer 选中 Reverse Angle 0 Scale 84%

   

               图21-62  原图像                            图21-63  Linear Style效果图

  

           图21-64  Radial Style效果图                      图21-65  Angle Style效果图

   

        图21-66  Reflected Style效果图                     图21-67  Diamond Style效果图

21.3.11  Pattern Overlay 图案覆盖

单击效果菜单中的 Pattern Overlay 选项 就会打开如图 21-68 的窗口



图21-68  Pattern Overlay的对话框

从对话框中我们会发现 窗口中所有的选项在前面的效果选项中都已经涉及到了 在

这个窗口中 Opacity 表示的是图案的不透明度 我们在这里只举一个例子说明这个选项

的用法 我们打开如图 21-69 的图像 再对图像进行如图 21-68 的效果处理 得到如图 21-70
的效果图 如果我们觉得图案在图像上的表现不是特别明显的话 我们可以更改 Scale 的

参数得到效果更加明显的图像 从这个例子我们也可以了解这个选项的用途 它可以在原

来的图像上加上一层 Pattern 图案 的效果 根据图案的颜色的深浅 在图像上表现为雕

刻效果的深浅 在使用中 我们注意调整图案的不透明度 否则我们得到的图像可能就知

识一个放大的 Pattern 图案

   

               图21-69  原图像                               图21-70  图像效果

21.3.12  Stroke 描边

这个选项是用来给图像描上一个边框 这个边框可以是一种颜色 也可以是 Gradient



渐变 还可以是一个 Style 风格 这在 Fill 选框的下拉菜单中可以知道 单击效果

菜单中的 Stroke 选项 我们会打开如图 21-71 的窗口

图21-71  Stroke对话框

下面我们来介绍一下这个窗口

•  Size 大小 它的数值的大小和边框的宽度成正比 数值越大的话 图像的边框

也就越大

•  Position 位置 这个选项产生边框的位置 可以是 Outside 外部 Inside 内

部 或者 Center 中心 这些模式是以图层的不透明区域的边缘为相对的位置

Outside 表示描边时的边框在该区域的外边 Photoshop 默认的区域是图层中的不

透明区域

•  Blend Mode (混和模式) 这些模式的种类和意义见前面的章节

•  Opacity 不透明度 它控制我们制作的边框的透明度

•  Fill 填充 在下拉菜单中我们会发现 可供我们选择的类型共有三种 它们分

别是 Color 颜色 Pattern 图案 Gradient 渐变 不同的类型窗口中的 Fill
选框的选项会更改 图中显示的是 Gradient 渐变 的选项

•  Gradient 渐变 其编辑和使用请用户参考前面的相关的章节

•  Style 风格 这里的风格和我们在前一节中提到的风格是一样的 但它多了一

种 Shape Burst 形状爆炸 这种类型下 边框的效果是以边缘为其实位置的渐

变组成的光环

•  Angle 角度 和 Scale 范围 的用法同前面章节中提到的是一样的 我们根据

图像选择合适的参数进行设定

如果我们在 Fill 选框中选择 Pattern 图案 选项的话  Fill 窗口部分就会变成如图 21-72
的选框 这个选框的使用方法和前面章节中提到的 Pattern 的使用方法是一样的



图21-72

如果我们选择 Color 色彩 选项的话 在弹出的选项中我们可以设置边框的颜色

颜色的选择和前面章节中提到的是一样的

前面我们说的这些知识比较抽象 我们在下面举一个例子将它们加以比较

     

                    图21-73  原图像                            图21-74  新建一个图层

1. 如图21-73 我们打开一幅图像 用椭圆选框在图像中选择一个椭圆形的区域 执行

Layer/New/Layer Via Copy 将选区的内容复制成一个新的层 这时的图层面板如图21-74
2. 我们对图像使用 Stroke 描边 在 Fill 填充 选框中 我们选择 Color 色彩

则将会得到如图 21-75 的效果图 这时的面板如图 21-76

     
               图21-75  Color描边图                                 图21-76



3. 我们双击图 21-76 面板上的 Stroke 描边 则又会弹出 Stroke 的对话框 这时我

们得到的效果 将会把原来的效果覆盖 在 Fill 填充 选框中选择 Gradient 渐变 我

们就得到了如图 21-77 的描边图

4. 在原有的面板的基础上 我们再双击面板上的 Stroke 描边 在弹出的窗口中我

们重新将 Fill 填充 的类型设置为 Pattern 图案 就会得到如图 21-78 的描边图

    

            图21-77  Gradient描边图                         图21-78  Pattern描边图

这些选项的参数的设置的技巧用户最好是多实践 同时参考我们在前面给大家的关于

这些框架的含义的介绍 这也是学习 Effects 效果 这一部分的诀窍 只有通过多加练习

我们才能达到熟练地应用这些丰富的图层的 Effects 选项 制作出丰富多彩的作品来 由

于这个选项具有可以重新设定的功能 所以我们对制作效果不好的图像 我们通过双击该

操作 可以重新设定其参数 增加了编辑的弹性

图层效果还有几个操作 我们已经在 Layer 一章中介绍了 在 Layer 中 我们可以对

编辑好的效果进行删除等操作

21.4  Layer Mask 图层蒙版

Layer Mask 图层蒙版 是用于控制图层中的不同区域如何被隐藏或显示 通过更改

图层蒙版 你可以将大量特殊效果应用到图层 而实际不会影响该图层上的像素 说得简

单一点 就是蒙版可以将你需要处理的图像部分以外的图像用一层 膜 封起来 在你处

理的时候不会影响到不需要处理的地点 在操作完成之后 你再将它去掉 你可以应用蒙

版并使所作的变化成为永久性 或去掉蒙版放弃所作的修改 你可以将所有图层蒙版与多

图层文档一起存储

当你要给图像的某些区域运用颜色变化 滤镜和其它效果时 蒙版能让你隔离和保护

图像的其余区域 当你选择了图像的一部分时 没有被选择的区域 被蒙版 或被保护而

不被编辑 你也可以将蒙版用于复杂图像编辑 比如将颜色或滤镜效果逐渐运用到图像上

另外 蒙版让你将花较多的时间制作的选区储存为 Alpha 通道并重新使用 Alpha
通道可以转换为选区 然后用于图像编辑 因为蒙版是作为 8 位灰度通道存放的 你可



以用所有绘画和编辑工具细调和编辑它们

21.4.1  新建 Layer Mask 图层蒙版

首先有一点要注意的是 蒙版只能在图层上新建 在一般的背景上是无法建立一个

Layer Mask 的 我们在打开一幅图像 将它转化为一个 Layer 后 单击图标 新建一

个蒙版 这时的 Layer 面板如图 21-79 其中各项的含义分别是

     

                图21-79  蒙版的Layer面板                图21-80  蒙版的Channel面板

•  A 蒙版的表示 这表示该图层处于蒙版状态 表示当前正处于蒙版状态下运行

•  B 表明蒙版和该图层处于链接状态 处于链接状态时 我们可以同时移动或者

复制 Layer 及其 Mask 如果没有该图标的话 只能移动图层

•  C 这是蒙版的图标 出现这个图标表明该图层处于蒙版状态 如果白色区域出

现红色的交叉的话 表示该蒙版现在处于停用状态

从图 21-80 的 Channel 通道 面板图中我们知道 图层蒙版实际上在 Channel 面板

中表现也是一个通道

新建的蒙版主要有两种 第一种是在整个图层中的不透明部分建立一个新的蒙版 第

二种是在图层的选区部分建立一个蒙版 我们经常需要单独对图像的某一部分进行处理

时 可以使用这种蒙版

1. 在图层的不透明区域建立 Mask 蒙版

在图层的不透明部分建立一个新的蒙版 我们通过两种模式建立蒙版则会产生如图

21-81 和图 21-82 的效果 首先我们在选中图层的情况下单击图标 就会出现如图 21-
81 的效果 如果我们按住 Alt 键后 单击图标 则得到如图 21-82 的蒙版效果

比较两个图 我们可以知道 直接单击图标 的话 我们是将整个图层置于蒙版之

下 即对图像进行处理时 整个图层都要受到影响 而如果我们选择按住 Alt 再单击图标

就得到如图 21-82 这时得到的蒙版是全黑的 表示处于该蒙版之下的区域是空的

而表现在画面上则是画像是透明的 这时如果对图层进行操作的话 在图层上是看不到任

何效果的



     

                   图21-81                                        图21-82

处于蒙版之下的区域是白色的 我们可以用橡皮擦工具或者画笔等工具修改蒙版的区

域 在如图 21-81 中 被画笔或者橡皮擦工具涂过的区域将被从整个图层蒙版区域中除去

在如图 21-82 中 我们做的操作不会影响图层

2. 在选区建立 Mask 蒙版

我们在图层上建立一个选区 然后将选中的区域建立一个新的图层 然后我们依据和

在图层上建立 Mask 蒙版 一样的方法建立和编辑蒙版 我们可以把在图层上建立 Mask
蒙版 看作是将整个图层当作一个选区所做的处理

在这种模式下 用画笔等工具对蒙版区域进行修改就显得更有意义 这些操作可以修

改我们的蒙版区域 使我们的操作在我们需要编辑的区域内进行

21.4.2  编辑 Mask 蒙版

编辑蒙版包括 Mask 蒙版 的删除和其属性的设置 在设置属性时 我们双击 Layer
面板上的蒙版缩略图 则会弹出如图 21-83 的窗口 在这个对话框中 我们可以设置 Mask

蒙版 的颜色和 Opacity 不透明度 这些参数的设置只是我们在编辑时用到 它不会

对图像的像素产生任何影响

图21-83

在我们完成对图层蒙版区域的编辑之后 我们一般要将蒙版删除 删除时 我们 选
中要删除的 Mask 蒙版 然后将它拖到图标 上 如图 21-84 所示

这时 Photoshop 会弹出如图 21-85 的对话框 我们可以选择 Apply 运用 即将蒙版

的效果运用到图像中去 选择 Cancel 取消 则回到图像中继续编辑 选择 Discard 丢

弃 表示将蒙版的效果丢弃 即图像回到蒙版以前的状态



     

           图21-84  删除Mask过程                       图21-85  删除Mask对话框

21.4.3  使用 Mask 蒙版

在前面我们已经提到过 蒙版可以用来控制接受操作作用的范围 在这一节中 我们

主要通过一个例子介绍 Mask 蒙版 的使用

1. 我们打开如图 21-86 和 21-87 的图像 我们要做的是将图像 1 中的恐龙的头像

精确地移动到图像 2 中 要精确地将它移动到图像 2 中 我们首先想到的可能是用

选取工具中的多边形工具或者磁性套索工具选取该头像 然后将它拷贝到图像 2 中

这种方法不是不可以用 但完成选取需要很长的时间 而且不易修改 我们现在用 蒙版

技术来完成这个过程

     
             图21-86  图像 1                               图21-87  图像 2

2. 我们用多边形选取工具将恐龙头像从图像 1 中粗略选出 并将它建立成一个新

的图层 如图 21-88 这时的 Layer 图层 面板如图 21-89
1. 将 Layer 图层 面板中的该层缩略图拖到图像 2 中 则会在图像 2 中新建

一个层 我们按住 Ctrl 键 并将恐龙的头像拖到合适的位置 得到如图 21-90 的效果 在

确定头像图层是当前的编辑层的情况下 我们单击蒙版图标 将头像图层的不透明部

分置于蒙版之下 此时 Layer 图层 面板如图 21-91



     

                     图21-88                            图21-89  Layer面板 1

     
                    图21-90                              图21-91  Layer面板 2

2. 如图 21-92 将图像放大 我们用橡皮擦工具对不需要的部分进行擦除 将图层中

的非头像部分删除 这时我们得到如图 21-93 的效果 这擦除的过程中 我们可以按住空

格键 这时鼠标变成手形 拖动鼠标可以观察我们对图层的整体处理情况 然后将图像回

到原来的显示比例

3. 在完成上述的操作之后 我们现在要将图层的蒙版删除了 删除时 我们将蒙版

拖到图标 在打开的对话框中 我们选择 Apply 应用 就得到最后的作品了

     

            图21-92  删除非选区                              图21-93  效果图



本章小结本章小结本章小结本章小结

本章可以说是第四部分内容的精华 而且图层也是 Photoshop 一个极为重要的部分

在这部分中 我们主要介绍了 Layer 面板的使用 并将介绍的重点放在 Effects 效果 和

Mask 蒙版 上 这两个部分对我们学习 Photoshop 是极为重要的

Effects 效果 这部分的新的内容比较多 这使得我们对图像的效果处理的难度大大

减低 我们可以将不同的 Effect 混合到一起 从而形成千变万化的效果 学习这部分的内

容 关键是要多使用

大部分的初学者不喜欢学习蒙版 这一方面是因为蒙版比较难理解 另一方面是一般

的 Photoshop 书中对这部分的内容的应用提得比较少 那些纯理论的知识十分难懂 这在

一定程度上挫伤了用户学习蒙版的积极性 这些枯燥的理论的只是给了大家一个错觉 蒙

版的用途不大 其实蒙版的用途很大 像我们举的例子中对图像进行精确的选择 将图像

比较融洽地放到一起



第二十二章  Channel 通道 面板

22.1  Channel 通道 的概述

在 Photoshop 面板中 除了 Layer 层 面板的功能十分强大外 通道也是其不可缺

少的特点 对于一个初学者来说 Channel 通道 是一个比较难懂的概念 他们在模仿

一些高手的作品时 常常会因为有个 Channel 通道 的步骤没有弄懂而无法成功地做出

应有的效果来 或者虽然也作出了几乎可以以假乱真的效果 但脑子里还是对通道没有一

个清楚的概念 通道表示了图像的大量的信息 它们是文档的组成部分 下面我们简单介

绍一下通道的用途

•  表示选区 可以利用分离通道作一些比较精确并很方便的选择 在通道中 白色

代表的是选区 在选中某通道后 用魔棒单击该通道的画面将会得到一个选区

这个选区的颜色就是白的 这一点我们在以后的章节会涉及到 我们将通过例子

说明

•  通道还可以代表 Ink 墨水 的强度 这个我们可以在分离的通道中观察它们的

亮度得知 不同的通道的亮度常常是不同的 尽管它们都是灰色的 举个例子

在我们打开某一张图像的 Red 红色 通道后 鼠标在图像上移动时 Info 信

息 面板上的颜色所在点的信息显示上只有红色选项有数值 其余均是 0 如果

某一点是纯红色的话 那么该点在灰色通道上显示的就是全黑

•  通道也可以是执行命令过程中的可变的不透明度 通过通道的设置可以改变通道

在我们眼中的颜色的深浅 从而达到改变不透明度的效果

 通道还代表着颜色信息 例如 RGB 图像的 R 通道代表图像的 Red 红色 信息

 除了以上这些功能外 通道还有一些其它的功能 在后边的章节中我们会通过解

说或者例子中提到

利用通道可以查看各种通道的信息 而且可以对通道进行编辑 从而达到编辑图像的

目的 图像颜色 模式的不同将决定通道的数量和模式 在面板中则表示为显示内容的不

同 在 Photoshop 中 涉及四个模式的通道 它们分别是

•  Compound Channel 复合通道 对于不同模式的图像 其通道的数量是不一样

的 Photoshop 通道中涉及三个模式 对于一个 RGB 模式的图像 有 RGB R
G B 四个通道 对于一个 CMYK 模式的图像 有 CMYK C M Y K 共五

个通道 对于一个 Lab 模式的图像 有 Lab L a b 四个通道

•  单个颜色通道 如果在通道面板中随意删除其中的一个通道的话 就会发现所有

的通道都变成 黑白 的 原来的彩色通道即使不删除也变成灰色的了

•  Spot Channe 专色通道 在面板的打开菜单里可以新建专色通道 而且我们可

以控制通道的参数



•  Alpha 通道 我们可以通过下拉菜单新建 Alpha 通道 这时得到的通道是全黑的

22.2  Channel 通道 面板

22.2.1  通道面板窗口

下面我们来看一看 Channel 通道 面板 如图 22-1

图22-1  Channel 通道 面板

通道面板中的各个符号的含义如下

•  A 单击图标 可以使通道在显示和隐藏之间变换 有一点需要注意的是

由于主通道是各原色的组成 在我们选中隐藏面板中的某一个原色通道时 主通

道将会自动隐藏 如果我们选择显示主通道的话 那么它的组成的原色通道将自

动显示 例如 在 RGB 模式的图像 如果我们选择显示 RGB 通道 主通道 则

R 通道 G 通道和 B 通道都自动显示

•  B 通道的缩略图 我们可以通过菜单中的选项改变它的大小

•  C 通道的名称 它能帮助你很快识别各种通道的颜色信息 各原色通道和主通

道的名称是不能改动的

•  D 打开通道的快捷键 此时打开的通道成为当前通道 而且在面板中按住 Shift
并且单击某个通道 可以选择或者取消多个通道

•  E 新专色通道

•  F 在面板中单击图标 则可以将通道中的颜色比较淡的部分当作选区加

载到图像中 这个功能也可以通过按住 Ctrl 键并在面板中单击该通道实现

•  G 在面板中单击图标 则将当前的选区存储为新的通道 而且在按住 Alt
键的情况下单击该图标 可以新建一个通道并且为该通道设置参数 如果按住

Shift+Ctrl 键再单击通道 则是将当前通道的选区范围加到原有的选区范围中去

•  H 在面板上单击图标 则可以创建新的通道 在按住 Alt 键并单击图标

的话 可以设置新建通道的参数 如果按住 Ctrl 的话 就可以创建新的专色通道

•  I 在面板上单击图标 则可以将当前的编辑通道删除



22.2.2  通道面板的打开菜单

  

图22-2

如图 22-2 我们打开 Channel 通道 面板右上角的菜单 则弹出如图 22-2 的窗口

在这个打开菜单里 包含了几乎所有通道面板的基本操作

1. 新建通道

在图 22-2 的窗口中选择 New Channel 新建通道 另外 按住 Alt 并单击图标

则将会出现如图 22-3 的对话框

      

               图22-3  New Channel对话框                       图22-4  Channel面板

从图 22-3我们可以看出在这个对话框内可以对新建的通道进行命名 还可以调整Color
Indicates 颜色显示方式 如图 22-4 在图中列出了三种模式 分别是

•  Masked Areas 蒙版区域 选择这个选项 则新建的通道中有颜色的区域代表被

蒙版的范围 没有颜色的区域则是选择范围

•  Selected Areas 选取的范围 选择这个选项 则得到与上一项选项刚好相反的结

果 没有颜色的区域表示被遮罩的范围 有颜色的区域则代表选取的范围

•  Opacity (不透明度) 见前面章节

•  在单击 Color 颜色 方块后 我们可以选择合适的色彩 这时遮罩颜色的选择

对图像的编辑没有影响 它只是用来区别选区和非选区 使得我们可以更方便地

选取范围 Opacity 不透明度 的参数设定也不影响图像的色彩 它只对遮罩起

 New Channel 新建通道

 Duplicate Channel 复制通道

 Delete Channel 删除通道

 New Spot Channel 新专色通道

 Merge Spot Channel 合并专色通道

 Channel Options 通道选项

 Split Channels 分离通道

 Merge Channels 合并通道

 Palette Options 版面选项



作用 这两个参数的设定只是为了更好地将选取范围与非选区明显区别 以便精

确选取

下面我们将举一个例子 这个例子一是巩固我们的新建通道功能 二是学习用通道精

确地选择图像

(1) 首先 我们打开一个 RGB 模式的图像 22-5

     

               图22-5  原图像                          图22-6  新建Alpha通道后的图像

(2) 我们按照前面所示的步骤新建一个通道 这时新建通道自动变为当前编辑通道

得到如图 22-6 的效果 我们将 Opacity 的值设置为 50% 因为这样能看清背景 如果改为

100%则画面变成全红的颜色了 看不到背景 无法进行选择

     
                   图22-7                                          图22-8

(3) 我们用橡皮擦将需要的选区内的遮罩擦去 这时会得到如图 22-7 的画面

(4) 按住 Ctrl 键 单击新建的通道 则得到如图 22-8 的效果 这就是我们需要的选区

了

(5) 这时将新建的通道删除 就得到了需要的选区

这里有一点要稍加注意 对于 Alpha 通道来说 双击通道 或者选择面板打开菜单的

Channel Options 通道选项 则将弹出如图 22-9 的对话框



图22-9

比起图 22-3 的窗口来 图 22-9 多了一个 Spot Color 专色 选框 选中该对话框的

话 它就可以将选中的 Alpha 通道变成指定颜色的 Spot Channel 专色通道

2. Duplicate And Delete 复制和删除 通道

在花了许多时间选出选区后 我们一般要用它建立新的层 或者复制到新的通道中进

行保存或者编辑 复制通道时 我们首先要选中该通道 然后执行面板打开菜单的 Duplicate
Channel 选项 这时会弹出如图 22-10 的对话框

图22-10

•  As 在这个框内我们可以对复制的通道进行命名 取个最好的名字以便以后用到

的时候加以区别

•  Document 文档 这个选项表示通道复制的目的地 一般有三个选择 而且它

只能显示与当前文件的分辨率和尺寸相同的图像 新建的图像文档成了其中的一

个 即通道被复制到一个新建的文档当中去 本身是一个 还有计算机默认的一

个模式 如果你选择的是 New 的话 你可以对它命名

•  Invert 反转 复制后通道的颜色会变得与原来的色相相反 原来是黑的现在就

是白的

最后我们讲一讲实际运用过程中的技巧 复制通道时我们也可以直接拖动通道到图标

上 删除通道时 我们只需将通道直接拖到图标 上就可以了 当然 也

可以选择在面板的打开菜单中执行 Delete Channel 删除通道 选项 有一点要注意的是

不需要的通道尽量删除 这样可以节省你的磁盘空间

对于一个含有多个图层的图像文档来说 在删除某通道时 它会首先弹出如图 22-11



的对话框 询问是否真的要删除该通道 在确定之后会出现如图 22-12 对话框 询问是否

将所有的图层合并并扔掉隐藏的图层 因为 Photoshop 在删除通道时不支持多图层操作

    
                    图22-11                                      图22-12

3. New Spot Channel (新专色通道)
专色通道是一种特殊的混和油墨 一般用它来替代或者附加到图像颜色油墨中 每一

个 Spot Channel 专色通道 都有属于自己的印板 在我们对一张含有专色通道的图像进

行打印输出时 专色通道将会作为一个单独的页被打印出来

新建 Spot Channel 专色通道 时 我们从面板的下拉菜单中选择 New Spot Channel
选项 或者按住 Ctrl 键并单击图标 则打开如图 22-13 的对话框 设定后单击确定就

可以了

图22-13

•  Name 命名 在这个文本框内 我们可以给新建的专色通道起名 默认的情况

下将自动起名 Spot Color 1 Spot Color 2 等依次类推 在 Ink Characteristics(油墨

特性)选项组中我们可以设定颜色和硬度

•  Color 颜色 设定专色通道的颜色

•  Solidity 硬度 可以设定专色通道的颜色的硬度 其范围是在 0 100%之间

这个选项的功能对实际的打印效果没有影响 只是在编辑图像时可以模拟打印的

效果 这个选项类似于遮罩颜色的 Opacity
4. Merge Spot Channel 合并专色通道

Merge Spot Channel 合并专色通道 指的是将专色通道中颜色信息混和到其它各个

原色通道中 它会对图像在整体上施加一种颜色 使得图像带上该颜色的色调 如图 22-14
22-15

这里再提一下通道的移动问题 除了原色通道不可移动外 其它同一类型的通道是可

以调整其相对位置的 但 Spot Channel 专色通道 一定在 Alpha 通道的上面 如果我们

确实需要调整 Spot Channel 和 Alpha Channel 之间的相对位置 则应该在 Image 图像

窗口的 Mode 模式 选项中将图像的模式改为 Multichannel 之后我们便可以调整两者

的相对位置了



      
        图22-14  新建专色通道前的面板图                22-15  新建专色通道后的面板

5. Channel Options (通道选项)
这个选项只对 Alpha 通道和 Spot Channel 专色通道 是可操作的 其的具体的用法

在前面已经谈过了 这里就不再叙述

6. Split Channels 分离通道

如图 22-16 和图 22-17 是 Split Channel 分离通道 前后的界面 在执行 Split Channel
分离通道 后 我们会得到三个通道 它们都是灰色的 分离通道后 主通道自动消失

例如 RGB 模式的图像分离通道后只得到 R G B 三个通道 分离后的通道相互独立 被

置于不同的文档窗口中 但是它们共存于一个文档 可以分别进行修改和编辑 在制作出

满意的效果之后 我们可以再将通道合并 Merge Channels

    

                   图22-16                                         图22-17

7. Merge Channels 合并通道

在完成对各个原色通道的编辑之后 我们将会执行 Merge Channels 合并通道 在

执行该命令时 将会弹出如图 22-18 的窗口

      

                             图22-18                              图22-19



合并通道的模式共有如图 22-19 中的四种 分别是 RGB 色彩模式 CMYK 色彩模式

LAB 色彩模式和 Multichannel 模式 模式的选择要由图像的模式决定 如果我们在图像中

加入新的通道的话 一般采用 Multichannel 多通道 的模式 Channels 选框决定参加合

并的通道的数目 通道数也是由图像的性质决定的 在设定各个参数之后 单击 OK 确定

则将弹出如图 22-20 到图 22-23 对话框中的一个

     

            图22-20  Merge RGB对话框                   图22-21  Merge Lab对话框

     
         图22-22  MergeMultichannel对话框               图22-23  MergeCMYK对话框

单击窗口中的 Mode 模式 图标 则回到如图 22-18 的窗口 可以重新选择

模式 在 Multichannel 模式中我们应单击下一步图标 直到将所有的通道都合并进

去 再单击 确定 在各个原色通道的选框内 我们可以改变通道在面板中的相对位

置 但是一个通道只能有单一的一种颜色 不能由两种不同的颜色混合而成 改变颜色通

道的相对位置有时会得到一些奇奇怪怪的图像 看起来有点梦幻的效果 用户可以在实践

中摸索得到 完成通道的合并之后 如果有没有参加合并的通道 它们将会自动回到文档

之中

在这里有一点需要注意 分离后的通道由于在不同的文档窗口中 所以我们不能通过

历史记录将它们还原到原来的文档 只能通过面板下拉菜单的 Merge Channels 合并通道

回到原来的文档

8. Palette Options 调板选项

在面板下拉菜单中选择 Palette Option 调板选项

则会打开如图 22-24 的对话框 从图中可以知道通道的

小缩略图是黑色的 如果我们需要清楚的分辨各种通道

代表的颜色 可由下列途径更改 执行 File >Preferences
>Display&Cursors 打开 Preference 对话框 选中其中

的 Color Channels In Color 复选框即可 这时通道面板

上的各个颜色通道即会显示该通道的颜色

图22-24  Channel调板选项对话框



22.3  Mask 蒙版 工具

这是一个用来保护一些区域使之不受编辑的工具 遮罩盖住的区域不会受到任何操作

的影响 在这一点上 Mask 遮罩 的功能和选取工具的作用是相同的 而且两者之间

可以互相转换 选取工具的选取范围可以进行修改 但 Mask 可以更加自由地修改遮罩外

的选区 它是可见的 我们能对它进行修改 扭曲和其它的变形 这在前面我们已经提到

在 Channels 中 白色的区域是被选中的区域 而带其它颜色的区域则是非选区

22.3.1  Mask 遮罩 的产生

遮罩产生的方法比较多 具体列举如下

•  我们在用选取工具 选择一个区域之后 执行 Select -> Save Selection 在弹出的

窗口中可以设置一些参数 就会得到一个 Mask 遮罩 具体的做法参见前面的

Select 章节

•  在 Channel 面板上单击图标 新建一个 Alpha 通道 在这个通道上我们用

等工具进行编辑 就会在通道上产生一个遮罩 白色区域是选区

•  在选定选区的情况下 单击面板上的图标 也可以得到一个 Mask 遮罩

•  在工具箱上有一个图标 单击该图标也会在图像上形成一个遮罩 具体的方

法可以参见前面的工具单元

22.3.2  Mask 遮罩 的使用

前面我们已经接触了许多有关通道的内容 但我相信有些用户对通道的用法还不是很

了解 在这一部分中 我们将通过两个例子的讲解来使读者达到掌握遮罩使用的目的 不

管是在 QuickMask 快速遮罩 下编辑图像 还是在 Channel 面板中的 Mask 下编辑图像

其最终的目的是一样的 都是为了转换为选择范围应用到图像中去

1. 利用 Mask 遮罩 进行精确选取

(1) 打开一幅图像 在图像中有 Photo 的英文 现在我们要将它精确的选出来 由

于文字的边缘和背景图像的界限十分模糊 很难准确选出文字 只能得到如图 22-25 的效

果 现在我们用 Mask 遮罩 进行选取 确切地说 是将选区进行修改 以得到需要的

选区

(2) 在用魔棒大致选出选区后 即在图 22-26 的基础上 单击面板的图标 就会

生成一个 Mask 遮罩 在 Channel 面板中会出现一个新的通道 其 Channel 面板前后对

比如图 22-27 和图 22-28

这时我们如果觉得原来的选区不好的话 可以单击工具栏中的图标 则原来的遮

罩自动消失 图像变成一般的模式 在执行产生遮罩的操作之后 则图像变成如图 22-29
的样子



     

              图22-25  原图像                          图22-26  魔棒选取文字后的图像

         

       图22-27  产生Mask遮罩前的Channel面板      图22-28  产生Mask遮罩后的Channel面板

(3) 在遮罩模式下 我们用工具栏的绘图工具对选区进行编辑 用画笔 将不需要

的选区部分填上颜色 这时在通道上就不会再出现被涂上颜色的选区范围 我们也可以用

喷枪工具 涂上颜色 需要注意的是 喷枪工具的选项中不能设置羽化参数 否则选区

的边缘将会模糊 而用橡皮擦工具 则是将需要的选区中的非选区删除 同样也要注

意它的设置 在我们用这三个工具配合选出合适的范围后 按住 Ctrl 键并且单击该通道

则会出现如图 22-30 的窗口

     

          图22-29  创建Mask后的图像                   图22-30  利用Mask选取的选区



(4) 在完成上述的步骤后 我们将该通道删除 即将 Mask 遮罩 删除 就得到如

图 22-31 的选区

图22-31  Mask得到的选取

运用 Quick Mask 快速蒙版 也可以进行选择 这在工具章节已经介绍了

2. 利用 Mask 遮罩 制作效果

在这部分中我们将通过一个例子 学习怎样利用 Mask 遮罩 将两个图像比较好地

融合到一起以更好的理解通道的用途

(1) 首先我们打开如图 22-32 和 22-33 两幅图画 我们现在要作的就是将图像 1 中

的花束选出 然后将它拷贝到图像 2 中 使它们比较自然地融合成为一张图 这中间

最难的就是如何将它们自然地融合 我们将用通道和蒙版完成这一任务

      

              图22-32  图像 1                              图22-33  图像 2

(2) 我们知道 刚打开的图像一般是一个背景 在删除多余的选取后是背景色 不利

于融合 于是先将图像 1 转化为一个图层 即双击图层的缩略图 在弹出菜单中单击

确定就可以了 这时图像就是一个图层 其背景是透明的

(3) 现在我们利用魔棒将图像 1 中的花束选出 这个图像花束和背景的界线比较

清楚 我们很快便能选出选区 然后执行 Select >Inverse 将选区反转 并且将该范围的

图像删除 则得到如图 22-34 的效果

(4) 现在单击图标 执行快速蒙版 得到如图 22-35 的效果图 这时在 Channel 通

道 面板上会出现一个新的通道 它的名称是 Quick Mask 快速蒙版 它的作用使我们



的操作在蒙版的区域内执行 使该区域外的图像部分不受影响

      

        图22-34  删除非选区后的图像                      图22-35  执行蒙版后的图像

(5) 在这一步 我们要对选区的通道执行 Gradient(渐变)工具 渐变的目的是造成图

像变化的效果 即会产生由上到下逐渐模糊的效果 渐变工具 的参数设置如图22-36 在

设置参数后 我们将会得到如图22-37的效果

图22-36  渐变工具的设置

      

             图22-37  渐变后的效果                     图22-38  移去蒙版后的效果

(6) 现在我们将蒙版移去 即单击图标 则出现如图 22-38 的选区 这个选区和一

般的选区是不一样的 它含有一些渐变效果 在下一步我们会体会到这一点

(7) 执行 Edit >Copy 将选区内的图像拷贝 然后激活图像 2 执行 Edit >Paste
命令 就得到我们的作品 如图 22-39

关于通道还有一些有关的内容 如 Image 图像 窗口中 Apply Image 应用图像

执行这个命令 可以将一个或者多个图像中的层和通道进行合并 使得 Photoshop 两个很

强大的功能进行混合 产生出更多的效果来 这部分内容我们在前面的相关章节已经提到

还有 Image 中的 Calculations 选项 它可以将同一个图像或者多个图像中的两个通道进行

混合 并将合成的结果保存到一个新的图像文档中去 这部分的内容我们也放在 Image 窗



口的相关章节中介绍

图22-39

最后补充一点 就像图层的效果的使用通过实践可以有效的掌握它的用法一样 实践

也是掌握通道和蒙版使用技巧的很有效的途径 通过练习我们会很快掌握它们的功能

本章小结本章小结本章小结本章小结

本章主要介绍 Channel 通道 和 Mask 蒙版 的用法 这是 Photoshop 中两个极为

重要的面板 首先我们必须承认 这是两个不怎么好懂的概念 但是 这些知识是我们必

备的 Channel 和 Mask 两个功能的联系比较紧 我们在学习是要注意将它们结合到一起

来理解

通过本章的学习 可以知道 通道组成了图像 不同模式的图像的通道的数量是不一

样的 而且通道的数量也决定着图像的大小 通道的数量越多的话 占用的内存就越大

不同的通道代表的图像的色彩信息也是不一样的

使用通道时 我们要在理论的指导下认真进行使用 学过其他软件的用户都知道 实

践是学习软件的最佳途径 有些知识是无法通过书籍得到的 我们自己实践得到知识总是

最牢固的



第二十三章  Path 路径 面板

关于 Path 路径 的概念在前面的工具栏章节中已经做了介绍 这里就不再重复 大

家都知道 使用路径可以完成一个精确的选取 我们经常用多边形工具及其相关的工具进

行选取 但这些选取方式的准确度通常不会很高 所以我们将它们转化为路径后 然后用

钢笔工具对它进行调整 再转化为选区 就可以得到精确的选取范围 在这一部分 我们

将主要对 Path 路径 面板的功能加以介绍 即将重点放在如何编辑和更好的应用路径上

23.1  Path 路径 面板介绍

Path 路径 面板可以说是集编辑路径和渲染路径于一身 在这个窗口中 我们可以

完成从路径到选区和由选区到路径的转化 还可以对路径施加一些效果 使得路径看起来

显得不那么单调 从 Window 窗口 中打开如图 23-1 的 Path 路径 面板

图23-1

下面我们来了解一下各个选项的含义

•  A 路径的缩略图 我们可以通过右上角下拉的菜单来改变它的显示模式

•  B 路径的名称 从图上可知 这是一个 Work Path 工作路径 后面的内容我

们会谈到 Work Path 工作路径 和 Path 路径 之间的区别和它们之间的转化

•  C Path 面板的下拉菜单

•  D 用前景色描边路径

•  E 用前景色填充路径

•  F 载入路径作为选区

•  G 从选区建立工作路径

•  H 建立新的工作路径或者复制路径

•  I 删除路径或者工作路径



23.2  Path 路径 面板的下拉菜单

单击 Path 面板右上角的小三角形 就会弹出如图 23-2 的选项

      

图23-2

下面我们将比较详细地介绍有关路径的操作

23.2.1  新建 Path 路径

新建路径的方法比较多 而且它们各有各的用途 现在列出以下几种

1. 用选取工具 或者其它工具在工作界面上选出一块区域后 单击 Path 面板上的

图标 即可得到一个 Work Path 工作路径 注意是工作路径 将工作路径转化为路径

的方法很简单 只要将工作路径拖到图标 上就可以了 这时路径的名称自动变为 Path
1 图 23-3 和图 23-4 表示了这个转化过程 从椭圆内 Path 名称的不同我们可以知道这一

点 同样 我们也可以通过打开菜单完成这一过程 只要选择菜单中的 Save Path 保存

路径 即可

     

            图23-3  工作路径示图                            图23-4  路径示图

2. 在打开菜单中单击 New Path 新建路径 也可以创建一个路径 这时会打开一个

如图 23-5 所示的对话框 在这个对话框内 你可以设定路径的名称 不过这个路径是 空

 New Path 新建路径

 Duplicate Path 复制路径

 Delete Path 删除路径

 Make Work Path 建立工作路径

 Make Selection 建立选区

 Fill Path 填充路径

 Stroke Path 描边路径

 Clipping Path 修剪路径

 Palette Options 页面选项



的 即你需要在上面用钢笔工具 填上自己需要的路径形状

图23-5  新建Path对话

3. 在按住 Alt 键的情况下 单击图标 则同样会弹出如图 23-5 的界面 从而建立

一个新的层 关于 Path 的命名问题 这里有一个小技巧 双击路径的缩略图 则可以对

路径进行重新命名 对话框和图 23-5 是一样的

23.2.2  Save Path 保存路径

如果将图像存成*.PSD 格式的图像文档的话 Photoshop 会自动将路径也保存下来

这样可以在下一次编辑的时候重新调出来 因为我们都知道 要做出一个比较精美的路径

的话 往往需要很长的时间 一般不可能一次完成 所以很有必要进行保存 这是在学习

Photoshop 中经常要注意的问题 一不小心就可能前功尽弃 反过来 如果我们存储为其

它的格式的话 那么下次我们打开图像的话 图像将不再包含有路径 即在存储时自动丢

失

选择下拉菜单的 Save Path 保存路径 则将弹出如图 23-6 可以对将要保存的 Path
进行命名

图23-6  Save Path对话框

23.2.3  Duplicate Path (复制路径)

对于一些已经进行精心制作的 Path 我们有必要对它进行备份 以免遇到非常情况

执行菜单中的 Duplicate Path 选项 将弹出如图 23-7 的对话框 同样可以对它进行命名

或者我们直接将路径拖到图标 上 就会自动复制出一个新的路径来 还有一个比较常

用的方法是可以利用它在不同的图像之间进行拷贝 即选择钢笔移动工具 将含有路径的

图像中的路径拖到另一个图像当中 就会在该图像中产生一个相同的路径

图23-7  Duplicate Path对话框



23.2.4  Delete Path 删除路径

虽然 Path 看起来很简单 但保存和运行它都需要不小的内存 为机器的运转速度考

虑 我们应该尽量删除不必要的路径 以节省空间 在删除路径时 我们可以在激活某路

径的情况下单击下拉菜单的 Delete Path 选项 或者单击 Path 面板中的图标 也可以直

接将该路径拖到该图标上即可 删除时 将会弹出如图 23-8 的窗口提示是否真的删除

单击确定即可

图23-8  Delete Path对话框

23.2.5  Turn Off  Path 隐藏路径

这个选项用以隐藏当前处于编辑状态的路径 这样我们就可以暂时不管该路径 进行

其它的操作

23.2.6  Make Work Path 建立工作路径

在我们用有关的选取工具选定一个区域之后 这个选项才是可用的 单击该选项则会

弹出如图 23-9 的对话框

图23-9  MakeWork Path对话框

Tolerance 容差 用来控制路径上的节点数 如果选区已经很精确的话 我们可以选

择容差大一点 这样得到的节点数就多一点 以便我们得到更精确的选区 选框内容差的

值的变化范围是 0.5 到 10 用户可以根据需要选择 对于非选区 例如 Path 这个选项是

不可用的 其运用过程如图 23-10 和 23-11 我们用多边形套索工具 选择如图区域 然

后再使用这个选项 就会出现如图 23-11 的 Work Path 工作路径 如果需要的话 我们

也可以将其转化为 Path

23.2.7  Make Selection 建立选区

这个选项的功能和 Make Work Path 的功能相反 建立工作路径是将选区转化为路径

而 Make Selection 则是将路径用选区表示出来 而路径仍旧保持 我们只要单击菜单上的

选项 Make Selection 建立选区 或者单击 Path 面板上的图标 则会弹出如图 23-12
的对话框 在设定参数之后就可以得到和路径相应的选区了 这也就是我们提过的用路径



进行准确选择的过程

    

              图23-10  制作选区                             图23-11  生成路径

图23-12  MakeSelection对话框

下面我们对图 23-12 的对话框加以解释 用户可以根据需要或者习惯设置该对话框

•  Rendering 渲染

•  Feather Radius 羽化的半径

•  Anti-aliased 消除锯齿

•  Operation 操作

•  New Selection 新的选区 就是在图像中由路径建立一个新的选区

•  Add To Selection 添加到选区 即原来已经有一个选区 现在只是将路径的选区

添加到原来的选区中去

•  Subtract  From Selection 从选区中减去 即原来的选区减去路径生成的选区得到

一个新的选区

•  Intersect With Selection 与选区交叉 即路径得到的选区与原来的选区相互交叉

互相不影响

23.2.8  Fill Path 填充路径

使用路径除了用来精确作一个选区之外 还有许多其它的功能 绘画就是其中的一个



用路径我们可以做出一些简单的卡通画 然后用 Photoshop 丰富的渲染工具 滤镜对它

们进行一些变化 就会得到一些精美的图像 在这中间 我们免不了要对路径进行填充

下面就介绍一下路径的填充

首先 在一幅图像中打开一个路径 然后单击 Path 面板的打开菜单的 Fill Path 选项

则将出现如图 23-13 的对话框

图23-13  Fill Path对话框

•  Contents 内容单元

•  Use 下拉的模式 我们用以填充的可以是颜色 也可以是图案和一些历史画笔

其下拉菜单见图 23-14
•  Blening 混和选项单元

•  Opacity 不透明度 要使填充更透明 使用较低的百分比 如果用 100%的设置

使填充不透明

•  Mode 模式 可以选择的模式和在 Layer 面板中提到的一样 如图 23-15 所示

•  Freserve Transparency 选中该复选框可以使图像的透明区域被保护起来 将填充

限制为包含像素的图层区域

•  Feather Radius 羽化半径 它的变化范围在 0~250 之间 羽化值的大小表示边缘

在选区边框内外扩大多远

•  Anti-aliased 消除锯齿 通过部分填充选区的边缘像素 在选区中的像素与周围

像素之间比较精细的过渡

关于图像的填充模式 其中 Pattern 和 History 在我们介绍工具的时候已经提过了 这

里不再介绍 其它关于颜色的模式相信大家都很清楚 这里也一并略过 这里要注意的一

点是 这 Edit 菜单中也有一个 Fill 选项 它和 Path 面板菜单的 Fill 的效果是不同的 Edit
中的 Fill 选项不能用于填充 Path



          

     图23-14  Mode菜单                         图23-15  Use菜单

23.2.9  Stroke Path 描边路径

这部分通过一个例子解说 Stroke Path 的使用 通过这个例子 我们也可以复习一下

路径工具的使用

1. 用钢笔工具建立如图 23-16 的路径

2. 用工具菜单的 对路径进行调整 从而得到如图 23-17 的效果

     

                图23-16  新建路径                        图23-17  调整路径

3. 同样可能对右边的节点进行调整 当然 调整可能不是很对称 调整后 就得到

如图 23-18 的路径

4. 现在我们对路径进行填充 填充的窗口如图 23-19 所示 选择其中的画笔工具加以

Stroke 描边 就得到如图 23-20 的效果

如图 23-19 从 Stroke Path 的对话框中 可以选择的描边工具共有 15 种 这些工具

在工具使用的相关章节已经学习过了 在逐个练习后就能熟练掌握它们的用法 并根据自

己的需要选择工具 如果我们选择的是 Fill 的话 那么得到的图像如图 23-21
描边得到的效果与我们选择的工具有直接的关系 还与该工具的相关设置有很重要的

关系 所以在执行描边之前 必须对与工具关系密切的参数进行设置 参数设置问题可以

 Foreground Color 前景色

 Background Color 背景色

 Pattern 图案

 History 历史画笔

 Black 黑色

 50%Gray 50%灰度

 White 白色



参考有关工具的章节

     

                 图23-18  完成的路径                      图23-20  完成的作品

       
               图23-19  Stroke Path对话框                     图23-21  Fill效果图

23.2.10  Clipping Path 剪贴路径

我们在处理一些图像时 常常需要将一张图像的一部分置于另一张图像 如图 23-22
中的两种效果 如果我们单纯将图像用矩形框选择 只能得到图中左边的效果 而如果我

们使用剪贴路径的话 那么便可以得到右边图中的效果 从这个例子我们就可以了解到剪

贴路径的强大功能了 它能除去所需图像的背景

图23-22  两种不同的效果



这里有一点需要注意的是 Work Path 下 Clipping Path 选项不可操作 只有在 Path
条件下才是可操作的 打开 Path 面板菜单下的 Clipping Path 选项 就会出现如图 23-23 的

对话框

 

图 23-23  Clipping Path 的对话框

•  Path 路径 在这个对话框中 有两个可供选择的 Path 如果选择 Path2 的话

那么路径 Path2 之内的图像就将会被输出 如果将它拷贝到一种图像上 就会发

现 输出部分的图像是透明的 其背景已经被除去了 而如果我们选择 None 的

话 那么 Photoshop 不会输出任何路径

•  Flatness 平滑度 为了使大多数图像得到较好的效果 让 平滑度 栏空白以

使用打印机的默认值打印 如果碰到打印错误 输入新的 平滑度 值

平滑度值范围从 0.2 至 100 通常 建议对于高分辨率打印 1200dpi 至 2400dpi 平

滑度设置为 8 至 10 对于低分辨率打印 300dpi 至 600dpi 平滑度设置为 1 至 3
在实践中 我们经常会将 Photoshop 制作的路径输出 当然 首先我们可以将它保存

在*.PSD 格式的图像中 或者执行 File >Export >Paths to illustrators 打开如图 23-24
的对话框

图23-24  Export Paths对话框

在对话框中我们首先可以在 File Name 选框中设置文件名称 然后在 Paths 选框中选

择要输出的路径 如果你的图像中有多个路径的话 在 Directories 中设置文档存储的位

置 而在 Drives 中制定存储的硬盘 可以注意到 文件的扩展名默认是.AI 现在如果你

的计算机已经安装了 Abobe Illustrator 软件的话 就可以在该程序中打开这个路径文件进

行修改和编辑了



23.2.11  Palette Options 调板选项

这个选项是用来调整 Path 面板上缩略图的显示模式 打开 Palette Options 弹出如图

23-25 的对话框

图23-25  PaletteOptions对话框

本章小结本章小结本章小结本章小结

本章主要介绍了 Path 路径 的使用 通过本章的学习 我们学会了如何建立一个新

的路径 并对该路径做一定的处理 这里有必要提醒一下 路径的使用不仅可以用来建立

路径 配合路径的填充和描边等其它选项工具 可以创作出许许多多的奇妙效果 本章例

子所使用的操作只是强大的 Path 面板的功能的一小部分



第二十四章  Character (字符)和 Paragraph (段落)面板

这是 Photoshop 新增的两个面板 它们是用来编辑文本的 在以前的版本中 我们主

要是在用 Type 植字 工具的打开菜单对文字进行编辑 在 Photoshop 6.0 中 我们不仅

可以在新设定的两个面板上对已经输入的文字进行编辑 还可以在窗口下的 Opaion 条形

选框上进行编辑 在新增加的两个面板中 Character 面板主要是用来编辑字符 而 Paragraph
面板主要是用来编辑段落

这两个面板的使用与我们使用 Word 的方法差不多 这使得 Photoshop 的文字处理能

力上了一个很大的台阶 在以前的版本中 我们植入的文字是不能直接进行 Filter 滤镜

处理的 这一点我想大多数 Photoshop 的用户对此都深有体会 我们经常会因为不能对文

字进行滤镜处理而无法达到预期的效果

24.1  Character 字符 面板

图24-1  Character面板

•  A 这个选框用以选择输入文字的字体 在下拉菜单中 我们可以选择比较适合

于作品的字体 菜单中的字体的种类和我们在 Window 中安装的字体的种类有关

一般情况下 我们在使用 Photoshop 时用 Photoshop 默认的字体 但我们在创作中

需要用到的字体这里几乎都有了

•  B 这是个和 A 配合使用的选项 它也是用以设置字体的选项 它的下拉菜单中

有时只有 Regular 通常 模式

•  C 字的大小 通过调整框内数值的大小我们可以改变字的大小

•  D 字距调整 它是用来调整相邻的两个字之间的距离的 注意有一点 这个选

项只是在不选择任何文字的情况下才是可以使用的

•  E 这个选项用以调整文字两行之间的距离

•  F 文字的跟踪 它是用以调整一个字所占的横向空间的大小 但是文字本身的

大小则不会发生改变

•  G 调整文字垂直方向的长度 用它可以调整出高度比宽度大的文字来



•  H 调整文字的横向方向的长度 用法同 G
•  I 这是用以调整角标相对于水平线的高低的选框 如果是一个正数的话 表示角

标是一个上角标 它们将出现在一般的文字的右上角 而如果是负的话 则它们

将代表下角标

•  J 单击该颜色块可以打开颜色选择窗口选择颜色

上面介绍了 Character 面板中各个选项的用法 从面板的使用中 我们可以发现这里

面包含了许多和 Word 相类似的功能 用户在使用这个面板时 可以参考以上介绍 结合

Word 的使用进行学习

从 Character 面板中 我们打开右上角的小三角形菜单 我们打开如图 24-2 的打开菜

单

    

图24-2  Character打开菜单

在这个菜单中 我们可以对输入的文字进行一些编辑 比如用粗体和斜体 可以输出

与一般文字不同的模式 还可以输出角标等 这些知识如果我们以前对 Word 用的比较熟

练的话 基本上对这些操作就不会有什么问题了 如果我们对这些知识不是很熟 通过使

用这些工具也可以很快地掌握这个菜单的使用

24.2  Paragraph 段落 面板

24.2.1  Paragraph 面板 介绍

这个面板主要用于对输入文字的段落进行管理 如图 24-3 我们首先来看一看

Paragraph 段落 面板的各个选项的含义

 Faux Bold 人工粗体

 Faux Italic 人工斜体

 Rotate Character 旋转文字

 All Caps 所有字母大写

 Small Caps 小的大写字母

 Superscript 上角标

 Subscript 下角标

 Underline 下画线

 Strikethrough 画线穿越

 Ligatures 结成字符

 Old Style 旧风格

 Fractional Width 微小的宽度

 No Break 不间断

 Reset Character 重置文字设置



图24-3  Paragraph面板

•  A 调整段落中各行的模式 矩形框中的左边第一个模式是段落中所有的行都左

对齐 而第二个模式则是段落中所有的行都居中 第三个则是段落中所有的行都

右对齐

•  B 这是用以调整段落的对齐方式 第一个是段落左对齐 这是我们经常用到的

模式 第二个是段落的最后一行居中 第三个是段落的最后一行右对齐

•  C 这个模式是段落中的最后一行两端对齐

•  D 调整段落的左缩进 即整个段落左边留出的空间

•  E 调整文字的右缩进

•  F  调整首行的左缩进 即第一行前面留出的空间

•  G 段落前的附加空间

•  H 段落后的附加空间

•  I 以连字符链接复选框 确定这些文字是否与连字符链接

24.2.2  面板的相关菜单

单击 Paragraph 面板右上角的小三角形 就会打开如图 24-4 的菜单

图24-4  Paragraph打开菜单

(1) Roman Hanging Punctuation 罗马悬挂标点

(2) Justification 调整段落中文字的样式 单击该选项 则会打开如图 24-5 的对话框

这个选框用来控制文字 字母和字的轮廓之间的距离 对于经过修改的文本 为了保

持整体的风格 我们很有必要对它进行修正 在这个选框中 我们可以调整文字的间距

Word Spacing 它就是我们按下空格键时鼠标跳动的距离 它下面设三个选框 有



Minimum 最小值 Desired 希望值 Maximum 最大值 我们根据需要调整希望值

文字间距的调整范围是 0% 1000% 如果选择的是 100%的话 那么在文字之间就不会有

附加的空间 为了使我们输入文字的整体效果比较好 一般将最小值和最大值的设置比较

接近

图24-5  Justification对话框

Letter Spacing 字母距离 这个选项下设的选框可以调整输入的英文字母的距离

这个距离包括字母之间的距离和字间距 它的调整范围是-100%到 500% 在我们选择 0%
时 两个字母之间不会有距离 调整的方法见 Word Spacing

Glyph Spacing 字的轮廓距离 是调整字的轮廓之间的距离 所谓字的轮廓 即指该

字所占的空间的大小

(3) Hyphenation 用连字符号连接 选中这个选项 我们会打开如图 24-6 的对话框

图24-6  Hyphenation对话框

在使用这个选框时 我们只有在选中左上角的复选框时对话框中的各个选项才是可用

的 在选框中 Words Longer Than 控制词首末能被链接符断掉的最小文字数量 After First
则决定连接字符前能被断掉的字母的最小数量 Before Last 控制连接字符后能被断掉的最

小字母数量 比如说 我们输入的数值为 3 则文字 English 将会被断成 Eng lish .Hyphen
Limit 连接限制 它控制的是行中的最大的字符数 如果选择数值 0 则表示我们可以

输入无限的字符 连接符号 它的单位是 Hyphen



Hyphenation Zone 连接区域 行末端连接符右边空出的最大距离 它决定行末端的英

文单词断掉的位置 这个选项一般是在对段落用了 The Single-Line Composer 后才使用的

Hyohenate Capitalized Words 连接大写的单词 我们一般不把大写的英文字母断掉

这时可以不选中该选框 如果我们把连接符号也用于大写的单词的话 就选中该复选框

对于这些工具的使用 我们仅限于介绍性的 因为这些选项的控制的内容基本上是针对英

文设计的 对于中文文字的处理效果不是特别的好 学习的时候我们以实践为主要的学习

手段

(4) Adobe Single-Line Composer 单行编辑器 单行编辑器提供了一种传统的途径来

一次完成对编辑文本中单行的编辑 这个选项可以控制如何对该行进行断点

(5) Adobe Every-line Composer(每行编辑器) 这是个和单行编辑器的用法类似的选项

不同的是 它不仅可以编辑当前所在的行的断点情况 还可以将前面的段落加以调整 除

去前面的不美观的断点 使得整个文本的整体效果更好

下面通过一个例子来讲解 Type 的用法

(1) 执行 Ctrl+N 新建一个图像文档 我们将这个文档的背景色设为白色 然后选择

Type 植字 工具 在画面上拉出如图 24-7 的文本框 并在上面输入 中华人民共和国

的字样 可以看到 Layer 面板中新增加了一个图层 这是因为在 Photoshop 中 新建的图

层将会自动生成一个图层

        
                图24-7  文本图                               图24-8  Layer面板

(2) 图中那个文本框是可以变形的 我们将鼠标移到各个节点中 则可以将文本框变

形 至于变形的方法 可以参照 Edit >Free Transform 选项的用法是一样的

(3) 这时我们可以单击任何一个工具 则可去掉文本框 这时我们可以试着执行 Filter
滤镜 的某一个滤镜 这时在 Photoshop 的界面上会弹出如图 24-9 的对话框 提示是否

将文本层转化为一个一般的图层 转化为一个一般的图层后 文本图层除了文字部分外

其余的部分均是透明的 在 Photoshop 6.0 中 我们可以将这个透明图层进行滤镜处理

图24-9



(4) 现在我们对图像执行某个滤镜 则得到如图 24-10 的图像 这时的图层面板如图

24-10

          

                  图24-10                                 图24-11  Layer面板 2

(5) 如果我们在这之后不对文本层进行其它操作的话 那么可以重新对它进行编辑

可以输入或者删除其中的部分或全部文字 但是经过其它操作的文本层是不能进行重新编

辑的

本章小结本章小结本章小结本章小结

本章主要介绍了 Photoshop 中两个新的面板 这两个面板是用来处理文本的 这部分

内容比较简单 但相对比较枯燥 对于一些 Word 用的比较熟练的用户来说 这部分内容

就比较简单了 因为这两个面板的使用基本上在 Word 中都涉及到 我们可以参考练习

通过这两个面板 我们可以处理出和用 Word 得到的效果相似的图像 用户在使用中

会慢慢体会到这个面板的强大功能



第二十五章  Adobe Photoshop 6.0 新功能总结

Adobe Photoshop 6.0 软件为用户提供了具有强大图形编辑能力的新特性 使用户能够

•  超越像素的扩展 Adobe Photoshop 6.0 利用集成的支持矢量图形的特性重新定义

了桌面图像编辑 从而扩展用户的创造范围 这样 用户就可以将可编辑的矢量

图形和文本结合到图像中 然后输出与分辨率无关的图形和文本 用户可以为高

端印刷生成 Adobe PDF 文件或者直接输出到 PostScript 打印机 Photoshop 6.0 也

可以打开具有内容层 Content Layer 图层风格 Layer Style 弯曲控制 Warping
Control 和其它具有灵感和创造特性的艺术选项

•  制作优秀的网络图像 Adobe Photoshop 6.0 扩展了其 Web 工具箱的功能 提供省

时的 面向产品的特性 并且与高级的网络图像处理工具 Image Ready 结合更加

紧密 Photoshop 的网络工具箱是 Web 设计师的基本工具

•  快速掌握 Photoshop 的强大功能 作为全球标准的图像编辑方案 Adobe Photoshop
以其强大的功能和广泛的使用而著称 但是它面临一个挑战 怎样才能让每一个人

都会使用其强大的功能 Photoshop 6.0 有数百处精细的增强——从在画布上直接输

入文本到直观的工具选项条——使用户易于快速应用和全面使用其特性 不管你使

用 Photoshop 多长时间 10 天或是 10 年 你的创造力都会能得到最佳的发挥

本章总结性介绍 Adobe Photoshop 6.0 的新增功能 并说明 Photoshop 怎样继续提供领

先世界的图像编辑方案 下面分三节依次介绍这些新功能

25.1  超越像素的扩展

通过引入可用于创建并输出清晰的 可编辑的矢量图形和文本的工具 Adobe
Photoshop 6.0 改变了传统的图像编辑概念 利用这些新增的矢量工具 你可以在设计杂志

封面 手提袋 信息图表等用于打印或网上发布的作品时将矢量图形或文本引入其中 以

期获得最佳的视觉效果 并且 比起纯粹的位图文件 矢量的引入不仅能够提高制作效率

同时也是一种较经济的表现手法 另外 Photoshop 6.0 还提供了 Content Layer 内容图层

和 Layer Style 图层风格 来提高图层设计的效率

25.1.1  优秀的矢量图形支持

Photoshop 6.0 提供了一个矢量图形工具 这个工具可以很快创造丰富多彩的基本矢量

图形 如矩形 圆角矩形 椭圆 直线和一般的矢量绘制工具不但可以绘制一些矢量图形

还可以用这些图形作为图形图层或者作为矢量蒙版 也称为剪贴路径 或者也可以作为

打印像素 当你选择一个绘制工具的时候 在 Photoshop 工作界面的最上方会出现一个工

具选项条 在这个选项条中 你可以很快地为你所作的图形设置一些选项的参数 例如你

在绘制一个矩形时 你可以选择是否束缚矩形的长和宽的比例 是否指定其是一个正方形



是否固定矩形的大小 是否以图形的中心为所绘制的矩形的中心 另外 在你开始绘制一

个图形之前 你可以选择一个图层风格 混合模式 还可以设定一个图形图层的不透明度

使用这些选项 你可以高效率地在你的图像中混合各个矢量 见图 25-1

图25-1  矢量绘制工具的相关图片

Photoshop 6.0 和其他像 Adobe Illustrator 等 Adobe 公司的产品一样 都提供了路径寻

找器 或称为导航器 操作 这些操作可以将基本矢量形状转化为难画的矢量形状 选项

包含增加 减少 交叉和排除 在任何时候 你都可以用新增加的直接选择工具选择或者

重新安排用钢笔或者自由钢笔工具所作的路径的锚点 也可以重新编辑你用基本矢量图形

所作的任何图像 当然 你也可以使用增加锚点和删除锚点增加和减少路径的锚点 然后

再用直接选择工具调整这些锚点

在你创作好一个矢量形状之后 如果你想以后还要用到这个矢量形状或者愿意和你的

同事分享你的作品的话 你可以将它存储为一般的矢量形状 Photoshop 会自动将矢量形

状存到一个默认的矢量形状库中 还有一种方法是 你可以使用预设管理员将绘制的矢量

形状存到一个独立的矢量图形库中 在使用这些选项时 我们可以从预设管理员处或者从

选项条中载入那些矢量图形库 由于矢量图形库是可携带的 所以工作组的成员之间可以

互相参考对方的作品 最后 这个新增加的矢量绘制工具是直接自动化操作的 因为它们

的行为是可记录的 所以我们在 Action 动作 面板中新建一个 Action 动作 的时候

可以包含矢量形状绘制 见图 25-2

25.1.2  矢量文本支持

使用 Photoshop 6.0 你可以很快将矢量文本和图像合并 然后输出有精确的文本边缘

和图像数据产生高质量的效果图 而且 Photoshop 6.0 所包含的扩展的新类型使你制作最



佳的变化效果成为可能 Photoshop 6.0 还提供了文本变形控制 你可以自由旋转和扭曲文

本来达到最佳的效果 最重要的是 这个文本将会始终保持可以编辑的状态 活泼的矢量

文本和图像数据的混合将使你的创造性得到更好的发挥

图25-2  Custom Shape Tool 一般矢量形状工具

25.1.3  基于矢量的蒙板

Photoshop 6.0 新增的矢量绘制工具的最强大的功能之一是创造可编辑的矢量形状 修

剪出图像的某些特殊的区域 利用直接选择工具 增加锚点和删除锚点工具 你可以调整

这些图层剪贴路径 为了得到一个软硬混合的蒙版边缘 你只需要将图层剪贴路径和蒙版

在同一图层上合并即可 或者 你可以用动态内容 如颜色 渐变 色调调整等填充图层

剪贴路径 从而产生许多难以置信的效果

Photoshop 6.0 也包含了界面连接增强功能 例如我们在选择路径工具时 在图像上单击

鼠标右键则可以在弹出的菜单中方便地选择对路径进行描边 填充 变形和移动 见图 25-3

图25-3  工具的右键弹出菜单



25.1.4  分辨率无关的矢量输出

创建矢量图形和文本并将它们合并到你的图像中只是整个工作流程的一部分 你还要

能够随图像的数据输出边界清晰的矢量图形 这些都必须有最高的打印效果 实际上

Photoshop 6.0 还提供了一个工作流程选择 你可以直接在打印机上打印独立矢量的图形和

文本 任何拥有 Adobe Acrobat 的服务器都可以将 PDF 格式的文件打印出来 从创建到

最后的打印效果 Photoshop 6.0 为我们提供了对不同的格式的图像支持

25.1.5  内容图层 Content Layer

图25-4  Content Layer对话框

在 Photoshop 6.0 中 你可以新建两种内容图层 调整图层和填充图层 调整图层长

久以来就是一个高效率的方法 它能将颜色或者色调调整图层迅速运用到一个或者多个图

层上 而不改变图像的像素 填充图层同样可以迅速地将可编辑的图案 渐变以及颜色运

用到图层中 Photoshop 6.0 允许你改变内容图层的类型而不删除原始图层或者图层蒙版并

且新建一个图层 例如 我们在对图像运用了色阶调整之后 如果我们觉得色彩调整可以

得到更好的效果的话 你只需要从一种类型的图层切换到另一种类型

新增的渐变 图案 填充 矢量形状和图层剪贴路径之间的相互协作很好 这有几个

简单的理由 通过简单的实践 我们就可以很快知道这些选项的用法和它们可能得到的效

果 例如 你可以创建一个红色正方形 然后用渐变 图案重新填充得到一种新的视觉效

果 当你在编辑一张图像时 这个动态编辑会使图像变得更加有趣

另外 Photoshop 6.0 包含一个新增的调整图层类型 称为渐变绘图 这个类型可以设

定图像的亮度值 也可将图像设置为一个渐变 你还可以使用这些选项将黑白的或者彩色

的图像转化为多色调的图像 渐变绘图包括色阶 曲线 颜色平衡 亮度和对比度 色相

和饱和度 通道混合器和极化 posterize 等一些选项

25.1.6  Layer Style 图层风格

Photoshop 6.0 提供了一个直观的效果选项 并且支持将对图像所作的效果保存为一个

新的风格 以便于以后使用



图25-5  制作Layer Style 图层风格 的对话框

图层效果 见图 25-6 最初是在 Photoshop 5.0 中提出的 图层效果提供了一个快速

的路径应用 通过这个操作我们可以应用投影 发光 浮雕和其他效果到图层中 在应用

之后 这些效果将会在你改变图层内容的时候自动升级 在设计可编辑类型的操作或者绘

制 Web 按钮和 Web 条时 这些效果选项都特别实用

图25-6  图层效果对话框

新的图层效果的定义和使用比以前的版本更加方便 这个图层风格对话框可以通过预

览被应用到 在对图层加入效果时 你只需要在列表中找出需要的对话框 然后设置该效

果作用到图像上的参数 Photoshop 6.0 的图层效果甚至支持更大的尺寸 你可以控制图像

接受处理的区域的大小

Photoshop 6.0 也介绍了新增加的图层效果 描边 覆盖 包括颜色覆盖 图案和渐变



绸缎 这些都是原来的图层效果选项得到加强 因为在 Photoshop 6.0 中 施加于图像的

图层效果并不一定是单一的 你甚至可以对图像施加全部的效果 而且比起以前的版本来

说 Photoshop 6.0 中的效果的打开对话框增加了一般和高级混合和不透明度的设置等 你

可以将你的操作结果存储为一个图层风格 最后 它对许多对话框的图层效果增加了轮廓

线这个选项 你可以用它来调整斜面 绸缎效果等风格

1. 图层效果的选项简介

Stroke 描边 可以对图像或者物体设置一个最宽为 250 像素 Pixel 的边缘 在

描边的对话框中 我们可以指定描边的位置混合模式 它所用的不透明度设置以及它被填

充时所用的模式 如颜色 渐变或者图案

Solid 固体 Pattern 图案 Gradient Overlay 渐变覆盖 可以创建与分辨率无

关的固体 图案和渐变填充物 或者 将这些填充物和不同的透明度 混合模式合并 产

生出特殊的效果

Satin 绸缎 可以创建一个阻碍图案 这个图案和图层的矢量图形相互作用产生一

种视觉上的金属化和发光的效果

Blend Options 混合选项 我们可以指定一般的和高级的混合模式 这些模式控制

一个图层效果如何与下面的图层相互作用 例如 建立一个图层来部分或者全部淘汰下面

的图像图层 这个选项用来制作好看的透明按钮效果时非常好 或者我们也可以限制某些

通道的混合 这样可以使图层风格只和图像的一部分色彩元素发生作用 而图像的其它元

素则不会有什么变化

2. 图层效果简介

Drop Shadow 投影 Inner Shadow 内阴影 你可以设置扩展和噪声的数值用以投

影 阻塞 也可以为内阴影设置噪声值

Inner Glow 内发光 Outer Glow 外发光 现在发光选项包含 Noise 噪声 Jitter
颤动 和 Spread 扩展 或者 Choke 阻塞 另外 在内发光和外发光对话框中 你

还可以指定一种渐变的颜色

Bevel 斜面 Emboss 浮雕 你可以在三个新增加的斜面技术 平滑 硬雕和软

雕 中选择一个 另外 你可以应用文本 轮廓线和金属化效果 还可以精确地控制投影

当你已经设计好一个图层效果之后 你可以将它保存为一个图层风格以便以后使用图

层风格使用时得到的效果和我们使用没有保存的图层效果得到的结果是一样的 当你改变

一个图层时 图层上应用的非破坏性的变化会自动升级 Photoshop 6.0 将风格存储在一个

默认的文件夹中 当然 你也可以通过预设管理器将风格存储到自己的风格库中 在使用

时 只要单击载入就可以使用了 由于风格库是可携带的 所以你可以将它们和同事们共

享 另外 Photoshop 6.0 图层风格和 ImageReady 是相容的 你可以在 ImageReady 中打开

一个风格库

应用图层风格是比较简单的 你可以创建文本 矢量形状和其他物体 然后在 Style
风格 面板中单击一个风格图标就可以了 或者 你可以选择一个矢量绘制工具 在选

项条中选择一个合适的图层风格 然后开始绘制 Photoshop 就会按照你所画的对图像应



用风格 对于一个 Web 设计者来说 图层风格和新增加的矢量工具的结合将会给他们的

创造性工作带来无穷的动力

25.1.7  Liquify Command(流体变形命令)

图25-7  Liquify Command对话框

用 Photoshop 6.0 中新增的流体变形 通过推拉 旋转 放大 缩小不同的图像区域

你可以很快的变形或者旋转一个图像 这些变形控制对于小图像的精美的扭曲调整都是比

较理想的 当你打开一个流体变形命令的窗口时 在图像上将会覆盖上一层网格 这可以

帮助你完成精确的调整 为了防止不必要的变化 你可以冻结图像上的某些部分 然后调

整你想要调整的区域 通过改变画笔的大小 你可以在大范围调整和精确调整之间切换

这个流体变形命令也提供了用来恢复原始图像的选项

25.1.8  增强对 PDF文件的支持

Photoshop 6.0 通过对 Adobe PDF 的进一步支持 扩大了 Adobe 产品之间的融合 这

包括在 PDF 文件中储存双色调 专色通道 透明度 图层 矢量物体 另外 你可以用

声音或文字来注释 PSD 文件 然后将文件以 PDF 格式输出 注释将被保留在 PDF 文档之

中 这样在不安装 Photoshop 的前提下就可以观看原来文件的大部分内容



25.2  制作优秀的网络图像

作为世界网络设计家眼中的高效工具 Adobe Photoshop 6.0 扩展了其 Web 工具箱的

功能 提供了省时的 面向产品的特性 并且与高级的网络图像处理工具 Image Ready 结

合更加紧密 在 6.0 版本中内置了切片工具 现在用户可以在 Adobe Photoshop 中切割图

片并输出或将切割好的图片转移至 Image Ready 中进行更多的操作 Adobe Photoshop 和

Image Ready 中都提供了动态图层切片 该切片以图层的边缘为边缘 当图层的边缘扩大

或缩小后 切片的边缘也自动扩大或缩小 新的滚动效果 增强的图像映射图支持 衡量

优化 Weighted Optimization 控制都可以帮助用户更好地完成网络图像 前面提过的矢

量绘图工具 图层风格都可以为制作精彩的网络图像提供更快速的解决方案 另外 Adobe
Photoshop 与 Adobe 公司的另一个首屈一指的网络编辑软件 Adobe GoLive 结合更加紧密

进一步扩展了 Photoshop 的功能 下面分别介绍新增的网络功能

25.2.1  切片 Slice 工具

现在 用户可以直接在 Adobe Photoshop 6.0 中分割图片 分割图片是使一幅复制的

图片成为网页的关键 以便网络浏览器可以更快捷的下载和显示切割的图片 另外 分割

图片可以更好地控制图片的优化 以便用户可以单独为每一个切片确定不同的优化方案

一旦完成了图像的分割工作 用户可以将它转移到 ImageReady 中设置滚动效果或增加动

画功能 或者可以直接从 Photoshop 中生产 HTML 页面 图 25-8 显示的是一幅经过分割

的图片

图25-8  分割后的图片



25.2.2  保存切片组 Slice set

Image Ready 中提供 Photoshop 中的所有切割功能 并且提供了如分割切片 合并切

片 复制切片 对齐切片 连接切片这样的高级功能 现在在 ImageReady 3.0 中 用户也

可以将多个切片保存成一个切片组 这样用户可以更为快捷地选择 优化 输出甚至删除

这个切片组

25.2.3  动态图层切片 Dynamic Layer-based slices

Photoshop 中提供了一个分割图片的新方法 在选中的图层中创建一种图层效果 然

后让 Photoshop 自动生产一个基于该图层的切片 当你创建一个这样的切片时 切片的边

缘是基于图层的最外层像素的位置 换句话说 切片将以最小的面积完全覆盖图层的全部

像素 如果改变图层的大小或改变图层的内容时 切片的边缘也将自动调整 以对应于图

层的改变 这一技术在制作精确的滚动效果时是很有用的 图 25-9 中的 Slice 03 既是一个

动态图层切片

图25-9  动态图层切片

25.2.4  与 ImageReady 3.0 结合更加紧密

Adobe Photoshop 6.0 与高级的网络产品 ImageReady 3.0 的联系比以前更为紧密 现在

你可以快速地在 Photoshop 和 ImageReady 之间进行转换 ImageReady 3.0 与 Photoshop 6.0
有着一样直观的界面 比如你选择了矢量图形工具 那么和矢量图形工具相关的选项都将

出现在属性条中 见图 25-10
ImageReady 3.0 与 Photoshop 6.0 有着相同的图层管理控制 流体变形控制以及字体和

段落控制选项 而且在 ImageReady 3.0 中同样提供了创造性的选项来控制动画和滚动效

果



图25-10  属性显示

25.2.5  滚动效果样式 Rollover Style

ImageReady 使设计滚动效果更为简单 即使你不知道如何编写 JavaScript 编码 它支

持两种类型的互动式滚动效果 一种是当鼠标经过某一个区域时在这个区域出现滚动效

果 另一种是当鼠标经过某一个区域时 在另外一个区域中出现滚动效果

ImageReady 3.0 提供了更为全面的滚动效果支持 更重要的是你可以将设计的滚动效

果样式保存在样式面板中 以确保再次使用 滚动效果的所有属性 包括各种效果 切片

等都将被保存在样式中 这样就可以通过单击保存的样式应用滚动效果 制作出互动式的

网络图像

25.2.6  增强的图像映射图 Image map

图25-11  设计一个滚动效果后将其命名并保存在样式中



在 ImageReady 中 用户可以用新增的矩形 圆形和多边形图像映射工具来确定 热

点 hot spot 并且为它们增加相关的 URL 网络地址 用户也可以设置基于图层的动

态图层图像映射图 Dynamic Layer-based image map 一旦你设定了这些热点 图像映射

图选择工具就可以用来选择和修改它们 比如选择一个热点 并在新增的图像映射图面板

中说明不同的属性 比如 URL 连接和 Alt 标签 在图像映射图面板中同样可以控制热点

的精确尺寸和位置

25.2.7  与 Adobe GoLive 紧密结合

图25-12  Image Map对话框

Photoshop 6.0 与 Adobe GoLive 5.0 结合紧密 可更好地完成用户的网络制作过程 现

在 用户可以将 Photoshop 的 PSD 文件直接置入到 GoLive 之中 在 GoLive 5.0 中内置了

图像优化工具以优化 PSD 文件 而且在 Photoshop 和 ImageReady 中编写的任何 URL 地址

都可以被 GoLive 管理和编辑

25.2.8  更快的创建网络图像

Photoshop 6.0 和 ImageReady 3.0 中的矢量绘图工具为网络设计师们提供了新的便利

现在用户可以更为轻松地设计各种网络按钮 导航栏 另外 新增的图层风格可以更轻松

地创建和保存面向网络的设计

25.2.9  附带预览功能

ImageReady 3.0 中包含了附加的预览功能 可以提高产品设计过程中的效率 现在用

户可以通过单击工具栏上的一个图标 在默认得网络浏览器中直接预览当前的文件 现在

用户也可以在不打开任何网络浏览器的情况下直接在 ImageReady 中预览滚动效果

25.2.10  增强的网络图片画廊 Web Photo Gallery

更完备的网络图片画廊功能 可以更好地控制网络图片画廊的外观 字体属性和画廊

中图片的优化方法

25.3  快速掌握 Photoshop 的强大功能

这一部分描述了 Photoshop 6.0 中一些较重要的改进 不仅在功能上有了明显提高

其界面设计也显得更为友好 使用户不用费较大的劲儿就能简单的操作 Photoshop 6.0 其

中 新增的功能包括 与工具箱密切相关的 工具属性栏 扩展后的图层管理控制 便



捷的预设管理器及文本的直接键入等

25.3.1  更为友好的界面

为了使用户能更简单更有效的利用其强大的功能 开发人员为 Photoshop 6.0 设计了

大量的新特性 例如 在工具箱中点击一种工具后 会在其弹出工具组中将给出隐藏工具

的名称及快捷键 便于用户更明了 更快捷地选择合适的工具 当文件中显现了标尺并想

要改变其单位时 只需在标尺上单击鼠标右键 在弹出菜单中选择满意的单位即可实现

在众多面板中 可以通过拖动鼠标将常用的面板组合到一起 定义用户自己的个性化界面

25.3.2  一目了然的工具属性栏

在 Photoshop 6.0 中 当你在工具箱中选择了一种工具后 则控制其行为的所有属性

都集中在其对应的工具属性栏中 我们以画笔工具为例来说明 在 Photoshop 以前的版本

中 画笔的属性呈现在两个不同的面板中 要设定混合模式 透明度 渐褪步数及其它的

一些选项 必须在 Paintbrush Options Palette 喷枪属性面板 中进行 要选择画笔种类

必须在 Brushes Palette 画笔面板 中进行 现在 在 Photoshop 6.0 中 这所有的一切属

性都集中在一个地方 工具属性栏 选择画笔工具后 其所有的属性都会立刻出现在工

具属性栏中 如图 25-13 所示 这样的用户就能进行更方便快捷的操作了

图25-13  新增的工具属性栏

25.3.3  增强后的图层管理

在 Photoshop 6.0 中 图层管理显现出了前所未有的灵活性 现在 你除了可以为图

像创建无数的图层以布置不同的元素外 还能将彼此关系密切的图层组织到一起 成为一

个 Layer Set 图层组 合理地创建图层组 能使 Layer 面板显得清楚有条理 更便于用

户对图层进行管理 对图层组的操作类似对图层的操作 你可以通过设定其可见性来显示

或隐藏图层组中的内容 也可以将图层蒙板和图层剪切路径应用于图层组 还能设定其不

透明度

在增强后的 Layer 面板中 对于设计好的图层 还能锁定对它的某种操作 如画笔的

应用 不透明度的设置和移动图层 以防止意外的操作改变该图层的图像信息



增强后的 Layer 面板还能使你更有效地管理图层效

果 你不仅能清楚地看到一个图层究竟具有哪些效果

还能将一个图层所具有的效果再运用到其他图层中 你

只需在 Layer 面板中点击所需要的效果并将其拖动到目

标图层中 即可完成添加效果的操作 并且保留住效果

的属性设置 如果双击某一效果 则会弹出 Layer Style
图层风格 对话框 在这里就可更改该效果的属性设

置

增强后的图层面板如图 25-14 所示

25.3.4  文本的直接键入

相信这一新功能会使所有的 Photoshop 用户感到高

兴 现在 你可以在画布上直接键入文本 并能在画布

上实现对文本的编辑操作 这样一来 你就能参照图像来调节文本直到最后获得满意的效

果 而无需像以前一样在画布和文本工具对话框之间来回切换了 对于某些其轮廓线数据

可用的字体 其对应的文本还能被转换为可编辑轮廓线 以作为蒙板或其它矢量元素使用

25.3.5  增强后的文本属性

Photoshop 6.0 中新增了大量的文本属性 对于风格化文字和段落显得非常有用 例如

你可以自由地扭曲文本 并且扭曲后的文本仍处于待编辑状态 所有的文本属性都集中在

Paragraph 面板和 Character 面板中 与 Adobe Illustrator 和 Adobe InDesign 中的设计相似

如图 25-15 及 25-16 所示 新增的段落面板使你能为每一段中的文字定制对齐方式 前后

间距等 通过控制文字的新增属性 你能为选定文字应用各种颜色 将其垂直缩放或水平

缩放以及设定基线对齐等

          
              图25-15  Character面板                      图25-16  Paragraph面板

25.3.6  Preset Manager 预设管理器

新增的预设管理器能使你对定制画刷 图形 渐变 轮廓 图案和图层风格进行集中

管理 当你创建了自己的定制预设后 利用预设管理器就能很容易地在库文件中保存它们

你也可以随时加载那些库文件或其它网上资源 见图 25-17

图25-14  增强后的Layer面板



 

25-17  预设管理器对话框

25.3.7  注释工具

当你的客户或同伴观看你的作品时 要让你的作品向他们传递全部必要的信息是十分

困难的 因此在 Photoshop 6.0 中增加了注释工具允许用户在的文件中增添文字或声音注

释 见图 25-18

图25-18  文字注释工具

25.3.8  增强的剪裁工具

在 Photoshop 6.0 中剪裁工具出现在第一级工具栏中 而不是隐藏在面罩选择工具之

下 这样可以更方便地帮助用户剪裁扫描图像 另外当用剪裁工具确定一个剪裁区域后



剪裁区域之外的部分的亮度将变暗 这样可以更直观地确定剪裁区域

现在 剪裁工具可以用来改变被剪裁区域的透视感 在选项条上勾选 Perspective 的选

项 就可以改变图像的透视感 图 25-19

图25-19  用剪裁工具调整图片的透视性

25.3.9  修正后的 Extract Image 提取图像 命令

图25-20  Extract Image命令



在 Photoshop 5.5 版本中初次引进的提取图像命令提供了一种通过创建蒙板来分离具

有复杂的 难定义的边缘对象的方法 不过创建的蒙板必须通过辛劳的手动操作来完成

现在 Photoshop 6.0 引进了这一命令的增强版本 其中新增的 smart-highlighting 巧妙地

加亮 mask edge 蒙板边缘 和 mask cleanup 蒙版清除 工具能够帮助你获得既快又

好的提取效果

25.3.10  扩大了应用动作 Action 对文件进行批处理操作的支持

应用打开并将文件重新命名的选项 Photoshop 6.0 将文件批处理的过程进一步简化

在 Photoshop 6.0 中的动作中可以增加新的任务 比如确定工具选项 打印和页面设置的

参数 画笔的选择等等 另外 用户可以将动作转换成一个 Droplet 来执行批处理操作

这样为了引发批处理动作 你只要将一个装有图片的文件夹拖动到 Droplet 图标 图 25-21
上 Droplet 可以在不同的计算机平台之间共享 这样可以提高一个有多种操作系统的工

作组的集团效率

图25-21

25.3.11  支持更多的文件格式

现在 Photoshop 6.0 在输出 TIFF 和 PDF 格式时可以保留多图层 并且在保存成 TIFF
格式时支持包括 JPEG 和 ZIP 在内的更多的压缩选项 同时 Photoshop 6.0 增加了对 PBM
格式 Wavefront的RLA格式 Alias的PIX格式的支持 一个增强的对话框使得输入PhotoCD
图像变得更加简单
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